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My Fourth Shift Workplace 

Overview 

My Fourth Shift Workplace is a way of using your Fourth Shift system that takes advantage of using 

Internet-based technologies to generate and display the user interface of the Fourth Shift program. My 

Fourth Shift Workplace allows you to integrate Fourth Shift with your existing intranet or web-based 

resources. Both users and system administrators realize significant advantages in using My Fourth Shift 

Workplace including ease of use, simplified client setup and flexibility in work environments. 

My Fourth Shift Workplace contains the following primary technologies: 

• Portals. Portals are configurable views of your Fourth Shift data that can include the web- 

based version of the Fourth Shift program itself, as well as existing intranet resources, third- 

party browser-based applications, or even external Internet web sites. See "Using Fourth Shift 

Portals" in this manual for more information on creating and updating portal definitions. 

• Fourth Shift WebUI. Fourth Shift WebUI provides a web-like look for the Fourth Shift 

program. This user interface style is similar to the traditional Fourth Shift program, enhanced 

to operate in the way users expect web-based software to operate. 

• Connectivity Toolkit. The Connectivity Toolkit is a collection of browser-based customization 

tools for Fourth Shift WebUI. It enables advanced users and script programmers to tailor 

Fourth Shift WebUI to the unique needs of each user. 

Although no special client setup process is required, My Fourth Shift Workplace requires Microsoft Internet 

Explorer. On the server, My Fourth Shift Workplace uses Microsoft Internet Information Server to generate 

web pages that provide the functionality of the traditional Fourth Shift program. 

This section contains both background information about My Fourth Shift Workplace and information about 

configuring your environment. There are some basic concepts you should understand before you begin. 

For more information on these concepts, see "Using My Fourth Shift Workplace" in the Fourth Shift Basics 

online manual. 

 
 

Requirements 

This documentation assumes you have met the following requirements. 

 

Knowledge Requirements 

My Fourth Shift Workplace relies on a number of technologies that may not be familiar to you. This 

documentation assumes that you have basic understanding in a number of areas, including: 

• Windows system administration including creating users, groups, assigning security and 

creating mapped drives to other servers. You also need to understand the relationships of 

these users to your domains. 

• Fourth Shift system administration including creating users, assigning security, using the 

FS.CFG file, installing the Fourth Shift client components and running the Fourth Shift 

database processes as applicable. 

• SQL Server system administration, including backup of the My Fourth Shift Workplace 

database and the Connectivity Toolkit UI database. 

• Microsoft Internet Information Server (IIS) basic operation and system administration 

including running the Internet Services Manager as well as installing and administering firewall 

technology. 
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If you are not familiar with these technologies, read the online documentation and supplemental 

printed resources, or complete training classes to acquire the necessary knowledge before you 

begin. A clear understanding of these technologies will enable you to reduce the implementation 

time and effort. 

 

Server Requirements 

Install My Fourth Shift Workplace on a server that can access the Fourth Shift database server 

using a mapped drive like any traditional Fourth Shift client. 

Note: The Portal manager module of My Fourth Shift Workplace uses an SQL server 

database to store its data. This database can be stored on any default instance of 

SQL Server on the network, including a local free copy of SQL Server Express. 

 
The optional module Connectivity Toolkit, must have a Locally installed default 

instance of SQL Server to store its database FSUIENU. This can be a free copy of 

SQL Server Express. 

The server used for My Fourth Shift Workplace must: 

• be running a supported version of Microsoft Windows Server according to the Fourth Shift 

Release Notes. 

• be running Microsoft Internet Information Services (IIS). 

• be running a supported version of Microsoft Internet Explorer according to the Fourth Shift 

Release Notes. 

• have a drive mapped to the Fourth Shift database server like any traditional client accessing 

the system. 

If you need more information about these requirements, please consult your Windows server 

documentation. 

 

Client Access Requirements 

Clients can access My Fourth Shift Workplace through your LAN or across the Internet. In either 

case, the following are required: 

• A supported version of Microsoft Internet Explorer according to the Fourth Shift Release 

Notes. 

• Ability to access the URL address of the My Fourth Shift Workplace server either through the 

LAN or across the Internet. Domain name services must be properly set up in order for the 

client to access the URL address. 

There are numerous ways to allow your users to connect to the Internet. This documentation does 

not outline these methods. 

 
 

Architecture 

The architecture of My Fourth Shift Workplace allows users to complete transactions through a 

browser while working within your local network or remotely through the Internet. The underlying 

application for My Fourth Shift Workplace runs as a web site on a standard IIS web server. From 

the web server, connections to the Fourth Shift server are made. 

In addition, the architecture supports users running the traditional LAN-based architecture, Net UI 

clients and My Fourth Shift Workplace clients at the same time. This allows you to select the most 

appropriate access method for each user. 
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My Fourth Shift Workplace Web Server 

The web server runs the "web site" that makes My Fourth Shift Workplace operate. The My Fourth 

Shift Workplace installation completes a series of web server setup steps such as installing the 

files and defining the web site. From a Fourth Shift standpoint, this server is treated like a 

traditional Fourth Shift LAN client. 

This server manages the individual user sessions accessing Fourth Shift. Traffic expectations 

should be considered as you select and set up this server. For example, if you expect a large 

number of users to access through the web server, consider using dedicated servers and higher 

performance servers. 

Users access this server by entering the URL address specific to the web site created for My 

Fourth Shift Workplace. For example, http://FSWebServer.company.com/fsportals. 

 

Fourth Shift Database Server 

Your Fourth Shift system is usually run on a server with your database manager, related files, 

supplemental data, and support programs. No additional installation from the My Fourth Shift 

Workplace installation media is needed on the Fourth Shift server to support My Fourth Shift 

Workplace. 

 

My Fourth Shift Workplace Internet Users 

Internet users are generally considered remote users. Using some connection method, such as 

through an ISP (Internet Service Provider), users connect to the Internet so that the URL address 

entered can be located. To start Fourth Shift, users open Internet Explorer and enter the address 

for the server where the My Fourth Shift Workplace web site is running. Standard Internet data 

encryption security standards can be utilized. 

 

My Fourth Shift Workplace LAN Users 

My Fourth Shift Workplace LAN users can access URL addresses within the local area network. 

For example, they can access a corporate intranet even if they cannot access another site outside 

of their network. LAN users are not required to have access to the Internet if the URL address 

needed for My Fourth Shift Workplace is already part of their LAN. 

 

Traditional Fourth Shift User 

Traditional Fourth Shift program users are set up using the standard Fourth Shift installation 

program. Folders and shortcuts are created on the Microsoft Windows Start Menu to provide 

access to Fourth Shift. An Internet browser is not used to access the Fourth Shift Windows-based 

programs. 

 

Net UI Users 

Net UI users can access Fourth Shift using a number of different thin-client options such as using 

the Internet or dial-up connection. Folders and shortcuts are created on the desktop to provide 

access to Fourth Shift. A supplemental process is run on the Fourth Shift server to provide Net UI 

users with the opportunity to create a connection to Fourth Shift. 

The primary difference between Net UI and WebUI is that WebUI provides an enhanced user 

interface that takes advantage of the Internet Browser and NetUI uses the same user interface 

used by the traditional Fourth Shift program. These two are the same in that the Fourth Shift 

application sessions will be run on the application server. 

See the Net UI manual for more information. 

http://fswebserver.company.com/fsportals
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Environment Example 

Your environment could look similar to the following: 
 

Local Area Network 

 

This is a fairly simple configuration example, including two servers and using a firewall for network 

security. There are many more configurations possible when installing My Fourth Shift Workplace. 

Be sure to consider the following suggestions and recommendations when deciding on the best 

configuration for your business. Some of these considerations overlap, and all must be considered 

before implementation. 

Number of Servers 
Your configuration can utilize a single server for all the required components, or you can install 

different components on different servers. The primary consideration when you are determining 

how many servers to use is network communication. That is, the communication between the My 

Fourth Shift Workplace Web server and the Fourth Shift server. 

A single server with all Fourth Shift and Workplace components installed does not have to 

communicate over the network. This can improve performance if the server is powerful enough. If, 

however, the server machine can not support the required number of users, using a single server 

may in fact slow down processing time. 

When deciding how many server machines to use, use the following software requirements to 

ensure all servers are running the necessary software components. 

 

This component... Requires this environment 

My Fourth Shift Workplace (FS Portals) Microsoft Windows Server 

Microsoft IIS 

.Net Framework 
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This component... Requires this environment 

Terminal Services (optional) Microsoft Windows Server 

Microsoft IIS 

Fourth Shift database server Microsoft Windows Server 

Microsoft SQL Server 

Fourth Shift (module) server Microsoft Windows Server 

.Net Framework 

 

Firewall Considerations 
Using a firewall to protect your internal network is strongly recommended. Implementing a firewall 

is one of the most common and effective ways to protect your internal network. 

When using a firewall, you should also use an internal DNS server rather than using an external 

ISP for your DNS resolution services. An internal DNS server eliminates the need to communicate 

outside the firewall to resolve machine names and IP addresses. This improves overall 

performance. 

Hardware Recommendations 
Hardware recommendations for My Fourth Shift Workplace vary based on the number of 

components installed on the server(s). The latest hardware recommendations are listed on the 

Fourth Shift Customer Support Bulletin Board. You can also contact the Technical Support group 

through Fourth Shift Customer Support for specific recommendations for your system. 

 
 

Client Operation 

My Fourth Shift Workplace clients are different from traditional clients in a number of ways: 

• Installation Process. No installation is needed for My Fourth Shift Workplace clients. Once 

My Fourth Shift Workplace is installed on the web server, users can access the URL and begin 

using the system immediately. 

Depending on the types of reports that need to be generated on the client, you may need to 

supply supplemental files, including the Fourth Shift Report Viewer, to some users. For more 

information, see "Workstation Setup Considerations" in the System Administration online 

manual. 

• Client Connection. My Fourth Shift Workplace clients communicate with the My Fourth Shift 

Workplace web server the same way users communicate with other web sites. The client 

connection is also similar to the communication methods used with Net UI clients (TCP/IP). 

• Data Communication. The My Fourth Shift Workplace web server uses traditional Fourth 

Shift client programs to connect to Fourth Shift, access data and complete transactions. 

Unique identifiers associated with each internet session are used to determine the number of 

user licenses active because of My Fourth Shift Workplace sessions. Users can have more 

than one Fourth Shift frame open and still use only one Fourth Shift user license. 

 
 

Security 

System security must be carefully considered when using My Fourth Shift Workplace. The 

following security issues and suggestions should be considered: 
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• If you allow My Fourth Shift Workplace client access over the Internet, your Fourth Shift server 

should be located inside a firewall in order to prevent unauthorized access to the system. 

• Local network clients use the local area network security implemented in your company. Be 

sure you have defined the necessary network security to support intranet user access. 

• The My Fourth Shift Workplace web server requires that port 80 be opened through the 

firewall just as typical web servers require if you want to enable Internet access. 

Note: You can install My Fourth Shift Workplace on a web server using a port other than 80, 

which should be opened through the firewall as well. 

• During My Fourth Shift Workplace installation, the challenge / response security option is 

selected. Users must have valid Windows network user security to be allowed access to the 

site. 

• Clients accessing Fourth Shift through My Fourth Shift Workplace continue to be required to 

enter Fourth Shift system user identification and password. 

There are additional security considerations associated with using portals. See "Using Fourth Shift 

Portals" for more information. 

 
 

Restricted Features 

My Fourth Shift Workplace contains the WebUI feature, which provides the core Fourth Shift 

program functionality. However, several modules and features are not supported directly through 

WebUI, though all of these can be accessed through My Fourth Shift Workplace using a Windows 

Terminal Server frame. 

 

Modules or Features Not Available with WebUI 

Several modules do not take advantage of the WebUI features. To be accessed from My Fourth 

Shift Workplace, these modules must be operated in a special type of frame called a Windows 

Terminal Server frame. 

Modules 
The following modules and features are accessible only through Windows Terminal Server frames 

in My Fourth Shift Workplace: 

• Engineering (ENGM) Module 

• Manufacturing Analysis (MMAM) Module 

• Rules Based Pricing (RBPM) Module 

• Sales Order Processing (SOPM) Module 

• Shop Floor Tracking and Reporting (SFRM) Module 

• Complementary applications 

In order to use these modules and features from a remote client, you may also consider using 

other remote client options like Windows Terminal Server (WTS) or Citrix. Contact Fourth Shift 

Client Business Solutions for more information about this software, and see "Running Microsoft 

Windows-based Applications in a Portal" for more information. 

 

Printing Options 
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Fourth Shift generates several types of reports. In WebUI, reports are usually displayed in a 

browser preview window, from which they can be printed and saved. When using WebUI, consider 

the following as you generate reports: 

• Screen Reports. Screen reports can be generated by choosing Preview or Print from the 

Reports menu. Reports are previewed in the web browser. 

• Batch Process Reports. When a batch process runs, reports are generated either to a file on 

the Fourth Shift server (Report Destination = 2) or previewed in the browser (Report 

Destination = 1). Once displayed, the user can choose to print the report or save it to a file. If 

the user wishes to use the report file generated (Report Destination = 2), the file must be 

transferred to the user's computer through a LAN or dial-up connection after the processing is 

complete. 

 

DOS Commands and Batch Programs 

WebUI clients can not run DOS or other commands using the CMND (DOS Command Shell) or 

PROG (Fourth Shift Program Execution) tasks. 

If a batch process includes either of these tasks, all tasks up to the unavailable task are executed. 

When an unavailable task is encountered, a message is displayed indicating the reason for the 

failure. 

Use the BSET screen to review the batch processes that contain the CMND and PROG tasks. If 

you need to complete batch processes that contain CMND or PROG tasks, use a traditional Fourth 

Shift client or a Windows Terminal Server frame within My Fourth Shift Workplace. 

 

Online Documentation 

Online documentation is provided in these formats from the screen you are using: 

• Context-sensitive help. Click the Help menu and select Screen Help to open the help file for 

that screen. 

• Field option definitions. Click the Help menu and select Field Action to list the options for a 

specific field’s drop-down menu. 

• Online printable manuals. Click the Help menu and select the Print Library button to open 

the list of help manuals in PDF format. These are printable versions of the context-sensitive 

module help files and the reference guides. 
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Using My Fourth Shift Workplace 

A variety of features are available in My Fourth Shift Workplace that allow you to enter and view 

the critical information that runs your business. This section introduces the important terms and 

concepts you need to know to use My Fourth Shift Workplace. It also describes the tools and 

options available to help you get the most out of the system. 

 
 

Overview 

My Fourth Shift Workplace provides an alternative method for remote and local users to access 

and use the Fourth Shift system. My Fourth Shift Workplace takes advantage of using an Internet 

browser and therefore provides a flexible and powerful tool for users that can result in increased 

productivity. 

 

What Makes up My Fourth Shift Workplace 

My Fourth Shift Workplace is comprised of two base elements, portals and Fourth Shift WebUI. An 

additional, optional, element is the Connectivity Toolkit. 

Portals 
With My Fourth Shift Workplace, you can create configurable views of information called portals. 

A portal can include the Web-based version of the Fourth Shift program itself, as well as existing 

intranet resources, third-party browser-based applications, or even external Internet Web sites. 

Each user can define portals of their own, as well as access the group of public portals. 

You can design portals to contain a variety of resources needed to perform a specific job. (For 

example, a portal for customer service representatives could include a set of commonly-used 

Fourth Shift screens, a Web-based customer relationship management system, and the DHL 

shipment tracking Web site.) Portals can also provide an overview to a specific segment of your 

business, such as a segmented view of continuously updated management reports. 

See Using Fourth Shift Portals in this online manual for more information on creating and updating 

portal definitions. 

Fourth Shift WebUI 
Fourth Shift WebUI provides a Web-like look for the Fourth Shift program. This user interface style 

is similar to the traditional Fourth Shift program, enhanced to operate in the way users expect web- 

based software to operate. 

Users can update and view data in real time, generate reports, run batch processes, and get 

online help just like traditional Fourth Shift users can. In addition, WebUI provides a number of 

advanced capabilities (such as Finders and links) that are unique to WebUI. 

 

My Fourth Shift Workplace Concepts 

My Fourth Shift Workplace is directly based on the traditional Fourth Shift system and functionality, 

but several new concepts are introduced to Fourth Shift users. 

Portals 
Portals are a collection of views that allow users to more efficiently do their jobs. This collection 

can include a variety of Fourth Shift data, or some Fourth Shift data along with other web content 

from your corporate intranet or outside companies. 
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Links 
Links are fields or data values that jump to related screens or detail information when clicked. 

When you pass your mouse over a field that has a link assigned, you can click on any of the 

destinations listed to go there immediately. 

Workflow 
Workflow describes the flow of transaction processing within Fourth Shift WebUI. Workflow allows 

you to continue working without memorizing all the steps in a process. Several workflow methods 

are used, including: 

• One-Step method. There is only one step within the transaction process. For example, a 

transaction is completed on one screen and you do not need to go to another screen to 

complete the process. 

• Multiple-Step method. Several steps are involved in the transaction process sequence. For 

example, transactions are entered on one screen, applied on another and completed on yet 

another screen. You can use the Next Step icon to go through the sequence in the transaction 

process. 

 
 

Getting Started 

Understanding several key concepts about My Fourth Shift Workplace, such as access, navigation 

and data entry can help you to use the system more efficiently. 

 

Accessing My Fourth Shift Workplace 

To access My Fourth Shift Workplace, enter the URL address of the web site created for My 

Fourth Shift Workplace. For example, you could use FSWebServer.company.com/fsportals. Once 

you have used the URL address to access the Web site created for My Fourth Shift Workplace, 

you access the portals to select the view in which you want to work. You can display the list of 

available portals by selecting its name in the upper-left corner. 

 

Navigating around Fourth Shift WebUI 

Several methods are available for moving between functions and navigating around Fourth Shift 

WebUI. 

Regardless of the list of the method used to navigate, you can only navigate to destinations that 

you are allowed to access as defined for your User Id on the FCMT (Function Code 

Maintenance) and PASS (Password Maintenance) screens. 

 
 

Function Field 
Each screen has a unique Function Code, which is a four-character shortcut that identifies the 

screen. For example, the Item Master screen is identified by the Function Code ITMB. Using the 

function code shortcut provides a quick way of accessing other screens. 

The Function field is displayed to the far left directly under the row of tabs in the WebUI frame. It 

displays the Function Code of the screen you are viewing. You can go to a different screen by 

entering the corresponding Function Code then click Go or press Esc or Enter. If the Function 

field is not displayed, you can press Back or Esc until you return to the main screen with the 

Function field. 

Tabs 
Tabs are available when a screen has additional related or required information for a transaction. 

Tabs are always shown, even if you cannot access them based on the data on your screen. For 
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example, from the MOAN (Planner Action) screen, you can see the Material Shortages Detail 

tab. But, if the item you are viewing doesn't have any material shortages, you cannot access the 

tab even though you can see it. 

When on a tab, the label Return is used for the main screen name, if the tab is accessed from 

more than one screen. 

Available tabs for each screen are listed on the Features tab when you select Screen Help from 

the Help menu. 

Links 
Many fields have been assigned links that allow you to jump to a related screen or detail 

information. Links provide easy access to related data. Fields can have several link destinations. 

• Clicking on a field that has one link takes you right to the jump destination. 

• Clicking on a field that has multiple link destinations takes you to the default destination. 

• Moving your mouse over a field that has multiple link destinations displays a list of the 

destinations. In the list, the most likely destination is listed first in bold font (this is also the 

default destination). 

For screens that have both entry and inquiry versions, you can be taken to the inquiry version if 

you do not have access to the entry version. For example, from the Item field you can click on a 

link to go to the ITMB (Item Master) screen. But, if you don't have access to that screen, and you 

do have access to the related ITMI (Item Master Inquiry) screen, you are taken to the inquiry 

destination instead. 

Available links for each screen are listed on the Features tab when you select Screen Help from 

the Help menu. 
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Next Step Icon 
Click the Next Step (arrow pointing right) icon, located to the right of the Function field, to go to the 

next set of screens in an application sequence. Next Step enables you to get to the next screen in 

a sequence without having to know the name of the screen. For example, from the ARCD (A/R 

Cash Deposits) screen, the Next Step icon takes you to the ARCR (A/R Cash/Credit Memo 

Application) screen, since it is the next screen in the cash application workflow. 

• The Next Step sequence is based on the "Typical Work Flows" diagrams in the Getting Started 

manual. 

• The Next Step sequence for each screen is listed on the Features tab when you select Screen 

Help from the Help menu. 

Back Icon 
Click the Back icon (arrow pointing left), located to the right of the Function field, to return to the 

previously viewed main panel. 

• The Back icon enables you to return to what you were doing without having to remember 

exactly what screen you were on. 

• The Back icon in My Fourth Shift Workplace works similar to the Back button in Internet 

Explorer, but it is specific to what you were doing in a specific Fourth Shift WebUI frame. 

Do not use the Internet Explorer Back button. 

 

Entering and Viewing Data 

My Fourth Shift Workplace is designed to allow you to enter and review business information 

quickly and easily. Most of the operations and techniques you can use are typical for Web-based 

programs. However, there are some special considerations to keep in mind while using My Fourth 

Shift Workplace. 

Selecting an Option in a Field with a Selection List 
Fields that permit only a limited set of entries contain a small arrow in the lower right corner. When 

the field gets focus, a drop-down icon will be displayed. You can either click this icon with the 

mouse or press Ctrl+Down Arrow keys to display the menu of options. Descriptions of the entry 

options are displayed at the bottom of the frame when you select Field Action in the Help menu. 

Selecting a Row 
To help you in determining if certain data rows can be selected, they are displayed slightly different 

than data rows that cannot be selected. 

• Blue Highlighted Background 

The current line has a blue background color. You can move the selection with the mouse or 

the keyboard arrow keys. 

• Selecting a Line 

- Clicking on a line in the detail grid of a main panel moves your cursor to that row. 

- Clicking on a line in a pop-up or browser window selects the row and returns the row 

to the parent screen. 

• No line marker 

Some pop-up and browser windows do not contain the arrow markers but you can still select 

from these windows. 

- Select a row to return to the parent screen whenever the hand cursor is displayed. 
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Using the Date Picker 
For date fields, click the calendar icon to open the date selector function (the Date Picker). 

Perform the following actions within the Date Picker: 

• Press Ctrl+Home to return to the current date. 

• Click the Today button to select the current date, which closes the Date Picker window and 

moves the cursor to the field with the selected date. 

• Click outside the Date Picker window to exit the Date Picker. 

Note: Shop days/non-shop days are not differentiated on the Date Picker calendar. 

Refreshing Data 
You can return a screen to its initial state at any time by pressing Esc. This clears all fields on the 

screen and allows you to enter new key values. An alternate way to refresh your screen is by right- 

clicking while you are on the screen and selecting Refresh from the menu. You may be prompted 

to click Retry in order for the data to be resent to the screen. 

If you have entered data on the screen but haven't saved it, those entries are lost when you 

refresh the screen. 

Saving Data 
You can complete a transaction and save data on the screen by clicking the Submit button, 

located near the bottom of the frame where a WebUI screen is displayed, or by pressing Enter. 
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Using Shortcut Keys for My Fourth Shift Workplace 

Keyboard shortcuts in My Fourth Shift Workplace are slightly different than the keyboard 

functionality of the traditional Fourth Shift program. In My Fourth Shift Workplace, users are 

provided with complete keyboard support, following Microsoft Windows and Internet Explorer 

standards. Many features also can be accessed with the mouse. 

My Fourth Shift Workplace keyboard support includes the following: 

 

Entering and Editing Text 
 

To... Press... 

Add a new line or section on screens where detail can be 

added 

Ctrl+A 

Copy selected text to the Clipboard Ctrl+C 

Delete the line or section containing the active field Ctrl+D 

Paste text from the Clipboard Ctrl+V 

Cut selected text to the Clipboard Ctrl+X 

Undo the most recent typing Ctrl+Z 

Save data to the database Enter 

Refresh the data Esc 

Moving Within a Screen 
 

To... Press... 

Go to the Function field Ctrl+G 

Go to the beginning of the active field Home 

Go to the end of the active field End 

Go to the first line in a list Ctrl+Home 

Go to the last line in a list Ctrl+End 

Go up one line in a list Up arrow 

Go down one line in a list Down arrow 

Go up one page in a list Page Up 

Go down one page in a list Page Down 

 

Moving Between Tabs on a Page 
 

To... Press... 

Move between tabs on a page Ctrl+1 for Tab 1, Ctrl+2 for Tab 2, etc. 
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Moving Between Screens 
 

To... Press... 

Go to the function code entered in the Function field Esc or Enter 

Go to a related screen or window Tabs, links, Next Step icon 

Go back to the previous screen Back button 

Using Menus 
 

To... Press... 

View context-sensitive help topics Ctrl+H for the Help menu 

View report generation options Ctrl+R for the Reports menu 

View available tools options Ctrl+T for the Tools menu 

Using Special Features 
 

To... Press... 

Open a Browse or detail list Ctrl+B 

Activate the Field Action Ctrl+F 

Close a Browse list after making a selection Ctrl+Enter 

Print a screen report Reports menu—Generate option 

Open an Extended Text window Tools menu—Extended Text option 

Open a Mass Maintenance window Tools menu—Mass Maintenance option 

Open the Cash Reversal Selection window from the 

ARCD (A/R Cash Deposits) or ARPD (A/R Prior Period 

Cash Deposits) screen 

Tools menu—Cash Reversal option 

Open a Default Setup window Tab or Tools menu— Default Setup option 

Select an option from a list * 

Go to next period on GLCF screen Tab 

Go to previous period on GLCF screen Shift+Tab 

Go to next fiscal year on GLCF screen Ctrl+Right arrow 

Go to previous fiscal year on GLCF screen Ctrl+Left arrow 

Open a drop-down menu Ctrl+Down arrow 

Go to the prior page of extended text Tools menu—Previous Page 

Go to the next page of extended text Tools menu—Next Page 

Add a new page of extended text prior to the currently 

displayed page 

Ctrl+A 

Add a new page of extended text while viewing the last 

page of existing extended text 

Tool menu—Next Page 
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Installing and Updating My Fourth Shift Workplace 

The My Fourth Shift Workplace installation is completed entirely on the web server that will be used to host 

the site. A separate ISO image and installation program are provided for this process. 

During the My Fourth Shift Workplace installation, or upgrade, the portals database will be updated using a 

trusted connection to access the database. The network login ID used to complete the installation must 

have sufficient rights to create tables, alter tables, and grant security permissions in the portals database. 

 
 

Overview of Installation Process 

Based on the module access key information stored in your Fourth Shift database, the Fourth Shift 

Portals, Fourth Shift WebUI, or Connectivity Toolkit components are available for installation. The 

installation process: 

• Creates the FSPortals, FSChart and FSWebUI directories as web sites on the Web server in 

the INetPub\WWWRoot directory. The FSUIEditor directory is also created if the Connectivity 

Toolkit is also installed. It is important that these directories exist on the same web server. 

• Completes the installation steps normally completed during a standard Fourth Shift client 

installation. This includes installing files, defining registry entries and creating desktop 

shortcuts. The installation program requires a mapped drive to your Fourth Shift configuration 

file. 

• Establishes a series of IIS settings that are used by My Fourth Shift Workplace. These settings 

should not be changed unless advised by Fourth Shift Customer Support. See "Default IIS 

Settings" in the Administering My Fourth Shift Workplace section of this manual for the list 

of default values. 

 
 

New Install: Server Installation Instructions 

Installation for My Fourth Shift Workplace includes installing the components on an Internet server. 

This Internet server is usually on the same local area network as the Fourth Shift database server, 

and is used for My Fourth Shift Workplace. See the Architecture topic in the WebUI Overview for 

more information. 

 

Implementing Client/Server Security 

Fourth Shift does not provide its own encrypted text security for data passed between the IIS 

server and a workstation using My Fourth Shift Workplace. In order to be more open-application 

compliant, we have taken advantage of the built-in encryption protocol included between IIS and 

Internet Explorer. 

To implement this encryption, you must purchase an encryption certificate from a certified security 

provider or write a private encryption certificate. Fourth Shift has tested My Fourth Shift Workplace 

with VeriSign Corporation certificates and has not found any compatibility issues. 

Fourth Shift strongly recommends that you implement encryption for any critical communication 

passing outside your secure LAN environment, especially if this communication passes over the 

Internet. 



Fourth Shift Release 8.00E Installing and Updating My Fourth Shift Workplace 

WebUI 19 

 

 

 

 

Verifying the Supplemental Software Installation 

Verify that the required software is installed on the appropriate computer. My Fourth Shift 

Workplace requires the following supplemental software: 

 

Computer Software 

My Fourth Shift 

Workplace Server 

Microsoft .NET 3.5 SP1 

Microsoft Internet Information Server (IIS) 

Microsoft Internet Explorer 11 

My Fourth Shift 

Workplace Client 

Microsoft Internet Explorer 11 

Installing My Fourth Shift Workplace on Internet Information Server (IIS) 

My Fourth Shift Workplace is installed on an Internet server using its own setup program. 

IIS for My Fourth Shift Workplace 
If you are using My Fourth Shift Workplace, you must make sure that certain role services are 

installed. To install the Web Server (IIS) role services, do the following: 

1. From Control Panel > Administrative Tools, open Server Manager. 

2. Go to Manage > Add Roles and Features. If the Before You Begin page is displayed, click 

Next. 

3. Choose Role-based or Feature-based installation. Click Next. 

4. Select the server from the Server pool. Click Next. 

5. On the Server Roles page, select Web Server (IIS). If it was already selected, skip to step 8. 

6. On the pop-up window for Add Roles and Features Wizard, click the Add Features button. 

On the Select Features screen, click Next. 

7. On the Web Server Role (IIS) page, click Next. 

8. Make sure at least the following role services are checked: 

• Common HTTP Features 

- Default Document 

- Directory Browsing 

- HTTP Errors 

- Static Content 

• Application Development 

- .NET Extensibility 3.5 

- .NET Extensibility 4.5 or 4.6 

- ASP 

- ASP .NET 3.5 

- ASP.NET 4.5 or 4.6 

- ISAPI Extensions 

- ISAPI Filters 
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• Health and Diagnostics 

- HTTP Logging 

• Security 

- Windows Authentication 

• Management Tools 

- IIS 6 Management Compatibility 

IIS 6 Metabase Compatibility 

- IIS Management Scripts and Tools 

9. Click Next. 

10. If you made any changes, click Install. Otherwise click Cancel. 

11. If the Installation Results page indicates that the installation succeeded, click Close. 

12. Exit Server Manager. 

WebUI Windows Account 
The WebUI Windows Account is a Windows user login that will be used by WebUI. This is needed 

because many users can start WebUI sessions, but a single identity is used to set their 

permissions. All WebUI processes and customizations will impersonate this user when accessing 

the system. 

The WebUI Windows Account will be used for: 

1. WebUI application sessions. WebUI will immediately impersonate this user when it starts an 

application session. This will be setup automatically by the Workplace Server installation. 

2. WebUI Finders. The WebUI Finders will impersonate this user when they browse the 

database. This will be setup automatically by the Workplace Server installation. If you wish to 

modify the WebUI Windows account after Workplace is installed, the Windows Internet 

Information Server utility can be used to change the identity of the FSWpAppPool application 

pool. 

3. Fourth Shift database. Since the WebUI processes run as this user, the WebUI Menu Explorer 

and the WebUI Finders connect to the database as this user and therefore need appropriate 

database access permissions set up. To accomplish this, assign the WebUI Windows 

Account user to the FSUSER role in the Fourth Shift database by performing the following 

steps: 

a. Open SQL Server Management Studio and Connect to the Database Engine. 

b. Go to Databases > FSDBXX > Security > Users. 

c. Right-click Users, click New User... 

d. If there is an Add button, click Add... 

e. Enter a User name. 

f. After Login name, click ... 

g. Enter the user name, click Check Names. 

h. Select the User Name, click OK. 

i. Click OK. on the Select Login window. 

j. On the Database User - New screen, click Membership page. 
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k. Select FSUSER, and click OK. 

You will be asked to identify the WebUI Windows Account when performing the Workplace Server 

installation. 

If you wish to modify the WebUI Window account after Workplace is installed, run the Workplace 

Server installation in repair mode, specifying a new account when prompted. Alternatively, the 

account can be updated in IIS Manager by updating the FSWPAppPool identity, and the physical 

path credentials for FSChart, FSPortals, and FSWebUI. Also, make sure that the account 

specified has access to the FSDBXX and, if applicable, FSUIENU databases. 

Choosing Login for Installation 
When completing the installation, use the user name that you want to become the main portal 

administrator and the one you will use to log into the server when My Fourth Shift Workplace 

sessions are running. This guarantees that the installation program sets up the correct user profile. 

This is especially important when the server is a Windows Terminal Server, because each user is 

assigned a different Windows directory. 

The user login used during installation of My Fourth Shift Workplace will become the default portal 

administrator login, which allows access to all administrative features for My Fourth Shift 

Workplace and Connectivity Toolkit. 

Installing My Fourth Shift Workplace 
1. Go to the My Fourth Shift Workplace server. 

2. Restarting the server is recommended to clear memory fragmentation. 

3. Ensure that the drive letter for your Fourth Shift system is mapped to the appropriate share 

name on your Fourth Shift server. 

4. If the Fourth Shift client workstation is not yet installed, follow the Workstation Preparation and 

Workstation Installation sections of the Installing Fourth Shift manual. 

5. Copy the Workplace Plus installation image (ISO file) for this release onto the local hard drive 

in a temporary folder. 

6. From the root of the Workplace Plus installation folder, double-click FSWorkplaceSetup. 

7. If you are prompted to install pending requirements, click Install. If you are asked if you want 

FSWorkplaceSetup to make changes to this computer, click Yes. Wait for the components to 

be installed. 

8. On the Welcome screen, click Next. The Locate Configuration File screen is displayed. 

9. Browse for the Fourth Shift Configuration File (for example, M:\Mfgsys\FS.CFG). 

10. Click Next. The WebUI Windows Account Configuration screen is displayed. 

11. Enter the domain user (in domain\user or user@domain format) and password for which 

WebUI applications can run to gain access to the Fourth Shift database, as described in the 

WebUI Windows Account section above. 

12. Click Next. The Database Server screen is displayed. 

13. Enter the following information: 

a. Database server name (with Instance Name, if applicable) for your FSWorkplace 

database 

b. SQL Server Administrator Login ID (sa) 

c. Password 

d. Check Create new database if you do not already have an FSWorkplace database. 
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14. Click Next. The Encryption Warning message is displayed. 

15. Read the encryption warning, check to accept responsibility for encryption 

considerations, and click Next. The Serial Number and Module Access Key screen is 

displayed. 

16. Confirm your serial number, browse for your key file if necessary, and click Next. The 

Custom Setup screen is displayed. 

17. Select the features to be installed, and click Next. 

18. If Connectivity Toolkit was selected, the Connectivity Toolkit Instance screen is displayed. 

19. Enter the sa Password, select the Local SQL Server Instance, and click Next. Note that the 

Connectivity Toolkit database must be on the local Workplace server. The Ready to Install 

screen is displayed. 

20. Click Install. 

21. If you are asked if you want to allow the program to make changes to this computer, click Yes. 

22. When the InstallShield Wizard Complete screen appears, check to Show the readme file 

and Show the Windows Installer log, and click Finish. 

23. Review and close the FSWP_README file and the FS Workplace installation history log file. 

Note: If any errors are detected in the log file, contact Customer Support. 

24. If you are prompted to restart your system, click Yes, and log back into the server when 

prompted. 

25. Using Windows Server Manager, turn off Internet Explorer Enhanced Security Configuration 

(IE ESC) for both Administrators and Users. 

 

Configuring My Fourth Shift Workplace on a Separate Server 

As of release 8.00E the configuration of Workplace on a separate server is significantly simplified. 

All that needs to be ensured is that the account specified as the WebUI account has the proper 

drive mapping to the Fourth Shift server, and includes the Mfgsys\System directory in the system 

path. Logging in with the WebUI account specified during the Workplace Server installation before 

performing the required Workstation installation process on the Workplace server is a good way to 

ensure these are configured. 

It is no longer necesary for the path to the Mfgsys\System directory under the Fourth Shift server 

share to be included in the system path as a UNC, but rather only as a directory on the mapped 

drive, as configured by the Workstation installation. And it is no longer neccessary to keep any 

account logged in on the Workplace server in order to access the mapped drive. 

 

Modifying My Fourth Shift Workplace Information 

Before accessing any portals using a My Fourth Shift Workplace client, complete the following 

steps on the My Fourth Shift Workplace server. 

Note: You may need to first setup Internet Explorer security for the web site on the local 

intranet, see Setting Up Local Intranet under Client Configuration. 

1. Open the Internet Explorer browser and navigate to http://localhost/fsportals; login if 

requested. 

2. Click the Preferences link in the portal bar on the upper-right side of the My Fourth Shift 

Workplace welcome screen. 

The Edit Preferences Portals window is displayed. 

http://localhost/fsportals%3B
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3. Click Locations ... 

The Edit Known Locations window is displayed. 

4. Select [FS Portals Server] from the Defined Locations list. 

5. Change the Location Name, if desired. 

You may consider adding the system name of the Fourth Shift system to the beginning of the 

Location Name. 

Note: Add a hyphen after the system name for readability. 

6. Change the Location URL if you have changed servers for My Fourth Shift Workplace. 

7. Enter the Configuration File location for the system you want to use, for example, 

M:\mfgsys\fs.cfg (for a single server configuration) or 

\\FSservername\FSHIFT\mfgsys\fswp.cfg (for a separate server configuration. 

8. Verify the Supported Frame Types options. 

9. Click Update to update this location in the FSWorkplace database. 

10. Click Close on the Information window. 

11. Click Close on the Edit Known Locations window. 

12. Close the Preferences Internet Explorer tab. 
 
 

Client Configuration 

While there is no setup program that needs to be run on a workstation that is a My Fourth Shift 

Workplace client, you may want to complete these configuration steps once on each client to make 

daily connections easier. 

 

Setting Up Local Intranet 

The Local Intranet zone must be set up for each My Fourth Shift Workplace client to allow access 

to the My Fourth Shift Workplace server. 

1. Go to the My Fourth Shift Workplace client. 

2. Open Internet Explorer. 

Run Internet Explorer as Administrator. If you get a message asking if you want the following 

program to make changes to this computer, click Yes. 

3. From the Tools menu, choose Internet Options. 

4. Select the Security tab. 

5. Click the icon for the zone you want to use (either Local Intranet or Trusted Sites). 

6. Click the Sites button. 

7. If available, click the Advanced button. 

8. Enter the URL address for the IIS server. 

For example: http://ServerName.DomainName. 

9. Do one of the following to verify that the Require server verification [https:] for all sites in 

this zone is set appropriately for the server: 

- If the server uses an SSL certificate, select the check box. 

http://servername.domainname/
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- If the server does not use an SSL certificate, do not select the check box. 

10. Click Add. 

11. Click Close. If the Local Intranet window is shown, click OK. 

If you are not using an SSL certificate on your server, complete the following steps: 

a. Uncheck the Enable Protected Mode check box. 

b. Click Custom Level... 

c. Set Submit nonencrypted form data to enabled, in the Miscellaneous section. 

d. Select Automated logon with current user name and password, in the User 

Authentication section, if you do not want your users to log in every time they access My 

Fourth Shift Workplace. 

e. Click OK. If prompted to change settings for this zone, click Yes. 

f. Click OK to close Internet Options. If a warning message appears, click OK. 

12. If you use the Local Intranet Zone: 

a. Click Compatibility View Settings from the Tools menu. 

b. Make sure that Display Intranet Sites in Compatibility View is not selected. 

c. Click Close. 

13. Close Internet Explorer. 

14. Repeat these steps on each My Fourth Shift Workplace client. 

 

Security Configuration 

The following steps must be completed on remote workstation for Internet Explorer. 

1. Go to the remote workstation, You may need to be logged on as the administrator on the 

computer to complete this process. 

2. Start Microsoft Internet Explorer (Run as administrator). if you get a message asking if you 

want to allow the program to make changes to this computer, Click Yes 

3. From the Tools menu, choose Internet Options. 

4. Choose the Security tab. 

5. For the zone, select the Local Intranet 

6. Click the Sites button. 

7. Click Advanced on the Local Intranet window. 

8. Enter the website URL for the Fourth Shift web server. For example, you might enter: 

http://Server1.MyCompany.com/FSWeb 

9. Click the Add button. 

10. Click Close to exit the Local intranet window. 

11. If the Local intranet window is displayed, click OK. 

12. With the Local intranet zone selected ,click the Custom level button for Security level for this 

zone 

13. Scroll to ActiveX Controls and plug-ins section. 

http://server1.mycompany.com/FSWeb
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14. Enable all options under ActiveX Controls and plug-ins.Be sure to enable “Initialize and 

script ActiveX controls not marked as safe”so that the ActiveX controls can function on the 

client machine . 

15. Click OK. if shown, click Yes to the confrimation message that you want to change the 

settings. 

16. click OK. 

 

Accessing Fourth Shift from the Client 

After completing the My Fourth Shift Workplace server installation, your system is ready for client 

access. There is no client installation required for My Fourth Shift Workplace. There is a web- 

based viewer component required to print certain types of reports. This viewer is automatically 

downloaded the first time you print one of these reports. 

Note: If you have an SSL certificate installed on the IIS server, the locations listed in this 

step begin with https rather than http. 

1. Right-click on the Internet Explorer program icon and select Run as Administrator. If you get a 

message asking if you want the following program to make changes to this computer, click 

Yes. 

2. Enter the following location: 

http://ServerName.DomainName/fsportals (where ServerName is the name of the My Fourth 

Shift Workplace server and DomainName is the name of your domain.) 

For example, you might enter: http://Server1.MyCompany.com/fsportals 

3. Log in, if requested. 

We recommend that you add this page to your favorites or create an icon on the desktop. 

Note: If a client needs to print bills of lading that include bar code fonts, the font must be 

installed on the client. 

 

Installing the Bar Code Font on the Client 

To install the bar code font on the client, do the following: 

1. Click Start Portal. 

2. Select A Simple FS Portal. 

3. Login to WebUI. 

4. Navigate to a screen, such as CNFG. 

5. Select Get VICS Bar Code Font from the Reports menu in WebUI. 

6. Click Run when requested. 

http://servername.domainname/fsportals
http://server1.mycompany.com/fsportals
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Registry Edit for My Fourth Shift Workplace Help 

My Fourth Shift Workplace users may require a system registry edit to view the help content. 

Note: You must have administrator rights on the workstation to enter this registry edit. 

The system administrator could implement this registry edit on all PCs on the Intranet using a 

Group Policy object. 

Follow these steps to update the registry for viewing help content from My Fourth Shift Workplace: 

1. Logon to the computer as the administrator. 

2. From Internet Explorer, go to My Fourth Shift Workplace. 

3. Click Start Portal and select “A Simple FS Portal.” 

4. Login to Fourth Shift WebUI. 

5. From the WebUI Help menu, select “Permit Help Display.” 

6. A message appears indicating a file will be displayed. Click OK. 

7. If you are prompted to open PermitHelp.txt, click Open. 

8. If you are asked how to open this file, select Notepad. 

9. From Notepad, read and follow the instructions: 

a. Replace all occurrences of “YOUR-SERVER” with your Workplace server name. 

b. Replace all occurrences of “YOUR-DOMAIN” with your domain name. 

c. If your site is using HTTPS, replace all occurrences of http: with https:. 

d. Click File Save As... and browse to a folder to save the file as PermitHelp.reg: You may 

want to save it in a common network location so other work stations can access it. 

e. Open the REGEDIT registry editor program as administrator. 

f. Click File Import... and browse for PermitHelp.reg, click Open, and click OK. 

g. Close the Registry Editor. 

10. You may need to logout of WebUI and close Internet Explorer and go back in to test Help. 
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Using the Find Feature 

The Find feature provides a quick and efficient way of searching for data to enter into an active 

field. This feature is sometimes called the Finder, since it enables you to search for specific data, 

such as customers, vendors, items, or orders. For example, if you need to enter a customer 

identifier, you can use the Find Customer link to choose the customer identifier from a master list. 

The master list can display more than just the identifier, it can also include the description and 

other information that you can use to choose the identifier without having to memorize it. 

Master lists can be narrowed down, or filtered, to display only data that meet the criteria you enter. 

For example, if you want to see a list of customers in a certain city, then you could enter that city 

name as the field criteria and only those customers in that city would be displayed in the filtered 

list. 

 

Accessing the Find Feature 

The Find feature can be accessed using the following methods: 

Accessed from a Field Within Fourth Shift WebUI 
Accessing the Find feature from within Fourth Shift WebUI enables you to quickly enter data into a 

field without having to memorize it and then you can continue on with your processing. 

From within Fourth Shift WebUI, you can access the Finder once the field gets focus. The small 

black triangle will be replaced with a trigger icon. This feature can be accessed from the keyboard 

or the mouse: 

• Using the keyboard, press Ctrl+Down arrow to access the Finder directly when the Find icon 

is displayed, or to drop down the menu when there is a menu of choices and the down arrow 

icon. 

• Using the mouse, click on the trigger icon and select from the menu if there are multiple 

choices. 

Accessed as a Portal Frame 
When setting up portals, you can create a portal with the Find feature by using the FS Finder 

frame type. The Find feature can be used independently or with other applications. For example, 

the Find feature can be the only frame in the portal, which enables you to search for Fourth Shift 

data. Or, the Find feature can be included in a portal that contains another frame that is running an 

application such as Fourth Shift WebUI. 

The characteristics of the Find feature when accessed as a portal frame are based on the options 

determined when the FS Finder frame type was created, including: 

• Parent or Child 

The Find feature can be set up as the parent frame of another application (for example, 

WebUI). 

• Logon Information 

For security reasons, when accessing the Find feature through a portal frame, you are 

prompted to log on to Fourth Shift. If your user’s authentication is “Fourth Shift” on the PASS 

screen, you can enter this log on information (user id and password) when creating the frame 

type so that you are not prompted for it when the Find portal is accessed. See Assigning 

Security for more information on assigning security in the Find feature. 

• Navigation 

When the Find feature is defined as a parent frame, an option is available to set the level of 

navigation. 
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- Option Not Selected—The Find feature (parent) sends a message to Fourth Shift 

WebUI (child) and if the desired screen is already displayed, the data is entered into 

the appropriate field. If the desired screen is not displayed, the data is not entered. 

- Option Selected—The Find feature (parent) sends a message to Fourth Shift WebUI 

(child) and Fourth Shift WebUI changes to a screen and the data is entered into the 

appropriate field. Navigation is based on which Find feature is open: 

 

Find feature Navigate to 

CO For CUSM systems: COMT, COMI 

For SOPM systems: no navigation 

Customer For CUSM systems: CUID, CUII 

For SOPM systems: no navigation 

GL Master Account GLMA 

Item ITMB, ITMI 

Lot LMST 

MO MOMT, MOMI 

PO POMT, POMI 

Vendor VEID, VEDI 

 
 

Understanding the Find Feature 

When accessed from a data entry field in Fourth Shift WebUI, the Find feature opens immediately 

in a separate window. If starting data was entered in the originating field before accessing the Find 

feature, this data is shown as the criteria for the search. If starting data was not entered, the Find 

feature opens with no pre-set filter criteria. After entering the criteria, click the Reload data icon 

and the Find feature displays the data matching the criteria. 

Filter Fields 
The fields used for filtering are based on the type of data you are finding. For example, if you are 

finding a customer, you can filter on customer data, such as customer ID, name, contact, phone or 

zip code. If you are finding a customer order, you can filter on order number, status, customer id, 

name or order revision date. Filtering fields have several other features, including: 

• Drop-Down Lists 

Filtering fields can be easily changed by using a drop-down list and simply selecting another 

field. For example, to filter the customer list by currency code, use the drop-down from any 

field selector and select the Currency Code field. You can then enter data in the criteria field to 

filter the list by a certain currency code. Field selectors without drop-down lists cannot be 

changed. 

• Field Labels 

Field labels used in the Find feature do not correspond exactly to the field labels used in 

Fourth Shift WebUI. The Find Feature lists similar fields in the drop-down lists together by 

function to simplify locating similar information. For example, all the fields relating to Terms 

start with the word "Terms"; and the field label "phone", which may appear several times, is 

identified as "contact phone" and "customer phone" in the Find Feature. 
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• Toolbar 

A toolbar is located at the top of the window and allows you to: 

- See which Finder is running and select a different Finder when run as a portal frame. 

- Use the Reload data icon to apply the query and reload the data grid. 

- Use the Save settings icon to save your settings on the client as described in the Save 

Settings section. 

- Use the Clear Criteria icon to remove the filter criteria from all fields. 

- Use the ? (question mark) icon to display the Help window to assist you with using the 

Finders. 

Criteria Fields 
Criteria fields are located directly below the filter fields and are available for entering field criteria. 

After entering filter criteria, click the Reload data icon to continue the process of finding the data, 

or click Clear Criteria to remove the filter criteria from all fields. 

For example, if you want a list of all customer identifiers that start with the number "12", select the 

Customer ID field, and then enter 12 in the criteria field. Click the Reload data icon to process the 

request, and a list of all customer identifiers that start with 12 is displayed. See Specifying Criteria 

for more information on using the criteria fields. 

Search Results List 
When the Find feature displays the data that matches your criteria, the results are initially sorted in 

ascending order based on the first column. You can change the following results list options: 

• Setting the records per page 

You can specify the number of records of returned data to display per page, based on your 

screen area settings. Enter a value in the Records Per Page field to change the display. The 

default number is 100. 

• Navigating through the list 

You can use the set of controls to navigate through the list of data. You can go to the first 

page, previous page, next page or last page. You can also navigate using the vertical scroll 

bar located on the right side of the list or using keys on your keyboard, such as Page Up, Page 

Down, arrow up and arrow down. 

• Sorting the Results List 

You can change the sort order by simply clicking on the header of another column. You can 

reverse the sort order from ascending to descending by clicking on a column header that is 

already sorted. The current sort field is identified by an angle bracket in the field header. 

• Changing Column Widths 

Change the width of the columns in the data grid by moving the dividers in the grid header. 

Data Selection 
When the Find feature displays the list, it also displays the record range and number of records 

found. You can select data by clicking on the row’s arrow marker. Data selection differs based on 

how the Find feature was accessed and if a level of navigation was specified. 

• When accessed from a field within Fourth Shift WebUI, the data value is entered into the field 

from which the Find feature was accessed. After the data is selected, the Find window closes. 

• When accessed from a portal frame, entry of the data is dependent on the frame configuration. 

For example, for a Find feature (parent) that is allowed to navigate Fourth Shift WebUI (child), 

Fourth Shift WebUI changes to the desired screen and then the data is entered into the 

appropriate field. When the parent frame is not allowed to navigate the child frame, the data is 
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entered into the appropriate field only if the desired screen is already displayed. After you 

select the data, the Find feature frame stays open and is available for more find activity. 

Save Settings 
After making changes to the Find feature settings, you may want to save the changes so that you 

don't have to enter them each time you open the Find feature on this workstation. Click Save 

Settings to save changes such as records per page, filtering fields, filter criteria and sort order. 

Settings are saved separately for each type of finder. 

Reset Finder Fields to Defaults 
If you have changed and saved the Finder fields, you can reset the Finder fields back to the default 

fields manually. The following is a list default finder fields for each of the Finders. 

• Customer Finder defaults 

- CSR 

- Cust Zip 

- Customer Contact 

- Customer Phone 

• Customer Order Finder defaults 

- Order Status 

- Customer Id 

- Customer Name 

- CO Rev Date 

• GL Master Account Finder defaults 

- Organization Description 

- Account Type 

- Account Category 

- Account Open or Closed 

• Item Finder defaults 

- UM 

- Make/Buy Code 

- Type 

- Order Policy 

• Lot Finder defaults 

- Lot User Def 1 

- Lot User Def 2 

- Lot User Def 3 

- Lot User Def 4 
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• Manufacturing Order Finder defaults 

- Order Status 

- Gateway WC 

- MO Rev Date 

• Purchase Order Finder defaults 

- Order Status 

- Vendor Id 

- Vendor Name 

- Rev Date 

• Vendor Finder defaults 

- Vendor Contact 

- Vendor Phone 

- Vend City 

- Vend State 

 

Assigning Security 

The traditional screen level security used by the Fourth Shift system is used to build the field level 

security in the Find feature. This field level security means that no additional work is necessary to 

make sure that users can see only the data to which they are permitted. 

• Fourth Shift Screen Level Security 

Screen level security can be assigned to the Fourth Shift screens using your User ID and the 

existing passwords, access codes and function codes specified on the PASS (Password 

Maintenance) and FCMT (Function code Maintenance) screens. 

Note: If you are using the Sales Order Processing Module (SOPM), the you must set up the 

following screens for the WebUI Find Feature to allow access to SOPM order entry 

data. 

- Name/Address Detail (SOP2) 

- Financial Detail (SOP3) 

- Order Information (SOP4) 

• Finder Field Level Security 

Field level security is built by the Find feature based on the screen level security of the PASS 

and FCMT screens. Since the fields available for filtering may originate on several different 

screens, the Find feature verifies that you have security to at least one of those screens 

before allowing you to view or filter on those fields. 

For example, if you have access to the Customer Financial Detail (CUS2) screen, the Find 

feature enables you to search and filter data available on that screen. If you do not have access to 

the Customer Financial Detail screen, the Find feature does not allow you to view or filter on 

fields from that screen. 

Security by Field 
Security for the Find feature is available by field. Security for several screens and fields is different 

based on if you use the CUSM or SOPM module. 
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Customer 

 

Field Security based on the panel 

A/R Customer CUS2/SOP3 

Acct Cntct Fax SOP2 

Acct Cntct Name CUS1/BR2C/SOP2 

Acct Cntct Phone CUS1/BR2C/SOP2 

Acct No: A/R CUS1/SOP2 

Acct No: COGS CUS1/SOP2 

Acct No: Freight CUS1/SOP2 

Acct No: Sales CUS1/SOP2 

AR Current Amt CUS2/BR2C/SOP3 

AR On Hold Amt CUS2/BR2C/SOP3 

AR Past Due1 Amt CUS2/BR2C/SOP3 

AR Past Due2 Amt CUS2/BR2C/SOP3 

AR Past Due3 Amt CUS2/BR2C/SOP3 

AR Total Amt CUS2/BR2C/SOP3 

AR Unappl Cash CUS2/BR2C/SOP3 

AR Unappl Credit CUS2/BR2C/SOP3 

Bank Ref #1 CUS2/SOP3 

Bank Ref #2 CUS2/SOP3 

Bill To Addr1 CUS1/SOP2 

Bill To Addr2 CUS1/SOP2 

Bill To City CUS1/SOP2 

Bill To Country CUS1/SOP2 

Bill To Cust Id SOP2 

Bill To Name CUS1/SOP2 

Bill To State CUS1/SOP2 

Bill To Zip CUS1/SOP2 

Bin SOP2 

Booked Orders CUS2/SOP3 

Carrier Code SOP2 

Commission Code CUS1/BR2C/SOP2 

Consumed Crdt SOP3 

Crdt Limit Amt CUS2/BR2C/SOP3 

Crdt Limit Auth CUS2/SOP3 
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Field Security based on the panel 

Crdt Limit Date CUS2/SOP3 

Crdt Pol: Assign SOP3 

Crdt Pol: Remove SOP3 

Credit Hold SOP3 

Credit Rep SOP3 

CSR CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/ 

SOP3 

Ctrl Currency CUS2/SOP3 

Currency Code CUS2/SOP3 

Cust Addr 1 CUS1/BR2C/SOP2 

Cust Addr 2 CUS1/BR2C/SOP2 

Cust City CUS1/BR2C/SOP2 

Cust Country CUS1/BR2C/SOP2 

Cust State CUS1/BR2C/SOP2 

Cust Zip CUS1/BR2C/SOP2 

Customer Class 1 CUS1/BR2C/SOP2 

Customer Class 2 CUS1/BR2C/SOP2 

Customer Class 3 CUS1/BR2C/SOP2 

Customer Class 4 CUS1/BR2C/SOP2 

Customer Class 5 CUS1/BR2C/SOP2 

Customer Class 6 CUS1/BR2C/SOP2 

Customer Class 7 CUS1/BR2C/SOP2 

Customer Class 8 CUS1/BR2C/SOP2 

Customer Contact CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/ 

SOP3 

Customer Fax # CUS1/SOP2 

Customer Id none 

Customer Level SOP2 

Customer Name none 

Customer Phone CUID/CUII/CUST/CUSI/BR2C/CUS1/CUS2/SOP2/ 

SOP3 

D & B Class CUS2/BR2C/SOP3 

D & B Date CUS2/BR2C/SOP3 

D & B Rating CUS2/BR2C/SOP3 

D & B Ref # CUS2/BR2C/SOP3 

Distrib Region SOP2 
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Field Security based on the panel 

Distrib Zone SOP2 

End User Id SOP2 

FOB Point CUS1/BR2C/SOP2 

Freight Code CUS1/BR2C/SOP2 

Last Inv Date CUS2/SOP3 

Last Pay Date CUS2/SOP3 

Open or Bal Frwd CUS2/SOP3 

Partial Alloc SOP3 

Partial Shpmnts CUS1/BR2C 

Price Adj S/D % CUS1/BR2C/SOP2 

Prt:Item Source CUS2/SOP3 

Prt:Lang Code SOP2 

Prt:Nbr/Date Fmt SOP2 

Sales Region SOP2 

Srvc Chrg Flag CUS2/SOP3 

Srvc Chrg Rate CUS2/SOP3 

Statement Cycle CUS2/SOP3 

Statement Print CUS2/SOP3 

Stockroom SOP2 

Tax Cert:County SOP3 

Tax Cert:Fd/VAT SOP3 

Tax Cert:Muni SOP3 

Tax Cert:St SOP3 

Tax Code:County SOP3 

Tax Code:Fd SOP3 

Tax Code:Muni SOP3 

Tax Code:St SOP3 

Tax Ex:County SOP3 

Tax Ex:Fd/VAT SOP3 

Tax Ex:Muni SOP3 

Tax Ex:St SOP3 

Term D:Csh1 % CUS2/SOP3 

Term D:Csh1 Days CUS2/SOP3 

Term D:Csh2 % CUS2/SOP3 
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Field Security based on the panel 

Term D:Csh2 Days CUS2/SOP3 

Term D:Csh3 % SOP3 

Term D:Csh3 Days SOP3 

Term D:Csh4 % SOP3 

Term D:Csh4 Days SOP3 

Term D:Net Days CUS2/SOP3 

Term M:Cutoff Dy CUS2/SOP3 

Term M:Due Day CUS2/SOP3 

Term M:Mth Delay CUS2/SOP3 

Terms Type CUS2/SOP3 

Text (addr) 1 CUS1 

Text (addr) 2 CUS1 

Text (addr) 3 CUS1 

Text (addr) 4 CUS1 

Text (addr) No CUS1 

Text (fin) 1 CUS2 

Text (fin) 2 CUS2 

Text (fin) 3 CUS2 

Text (fin) 4 CUS2 

Text (fin) No CUS2 

Top Level Cust SOP2 

Trade Class SOP2 

VAT Cust Code CUS1/SOP2 

YTD Payments CUS2/BR2C/SOP3 

YTD Sales CUS2/BR2C/SOP3 

YTD Shipments CUS2/BR2C/SOP3 

YTD Srvc Chrg CUS2/BR2C/SOP3 

 

Vendor 

 

Field Security based on the panel 

1099 Flag VEN1/BR2V 

1099 Tax Id No VEN1/BR2V 

Acct Cntct Name VEN1/BR2V 

Acct Cntct Phone VEN1/BR2V 
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Field Security based on the panel 

AP Current Amt VEN1/BR2V 

AP Fut Due1 Amt VEN1 

AP Fut Due2 Amt VEN1 

AP Fut Due3 Amt VEN1 

AP Fut Due4 Amt VEN1 

AP On Hold Amt VEN1/BR2V 

AP Past Due1 Amt VEN1/BR2V 

AP Past Due2 Amt VEN1/BR2V 

AP Past Due3 Amt VEN1/BR2V 

AP Unappl Cash VEN1/BR2V 

Bank Account VEN1 

Bank Name VEN1 

Bank Route VEN1 

Ctrl Currency VEN1 

Currency Code VEN1 

D & B Class VEN1/BR2V 

D & B Date VEN1/BR2V 

D & B Rating VEN1/BR2V 

D & B Ref # VEN1/BR2V 

Last Inv Date VEN1 

Last Pay Date VEN1 

Last Recd Date VEN3 

Order Value 1 VEN3 

Order Value 2 VEN3 

Payee Addr 1 VEN1/BR2V 

Payee Addr 2 VEN1/BR2V 

Payee City VEN1/BR2V 

Payee Country VEN1/BR2V 

Payee Name VEN1/BR2V 

Payee Name 2 VEN1/BR2V 

Payee State VEN1/BR2V 

Payee Zip VEN1/BR2V 

Payment Form VEN1 

Payments 1 VEN1/VEN3/BR2V 
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Field Security based on the panel 

Payments 2 VEN3 

Prt:Item Source VEDI/VEID/VEND/VENI/VEN1/BR2V 

Prt:Lang Code VEN1 

Prt:Nbr/Date Fmt VEN1 

Receipts Value 1 VEN1/VEN3/BR2V 

Receipts Value 2 VEN3 

Term D:Csh1 % VEN1/BR2V 

Term D:Csh1 Days VEN1/BR2V 

Term D:Csh2 % VEN1/BR2V 

Term D:Csh2 Days VEN1/BR2V 

Term D:Net Days VEN1/BR2V 

Term M:Cutoff Dy VEN1/BR2V 

Term M:Day Due VEN1/BR2V 

Term M:Mth Delay VEN1/BR2V 

Terms Type VEN1/BR2V 

Text (addr) Ln1 VEN1 

Text (addr) Ln2 VEN1 

Text (addr) Ln3 VEN1 

Text (addr) Ln4 VEN1 

Text (addr) No VEN1 

Text (conf) Ln1 VEN3 

Text (conf) Ln2 VEN3 

Text (conf) Ln3 VEN3 

Text (conf) Ln4 VEN3 

Text (conf) No VEN3 

Vend Addr 1 VEN1/BR2V 

Vend Addr 2 VEN1/BR2V 

Vend City VEN1/BR2V 

Vend Country VEN1/BR2V 

Vend State VEN1/BR2V 

Vend Zip VEN1/BR2V 

Vendor Approval VEDI/VEID/VEND/VENI/VEN1/BR2V 

Vendor Class 1 VEN1/BR2V 

Vendor Class 2 VEN1/BR2V 
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Field Security based on the panel 

Vendor Class 3 VEN1/BR2V 

Vendor Class 4 VEN1/BR2V 

Vendor Class 5 VEN1/BR2V 

Vendor Class 6 VEN1/BR2V 

Vendor Class 7 VEN1/BR2V 

Vendor Class 8 VEN1/BR2V 

Vendor Contact VEDI/VEID/VEND/VENI/VEN1/BR2V 

Vendor Fax # VEN1/BR2V 

Vendor Id none 

Vendor Name none 

Vendor Phone VEDI/VEID/VEND/VENI/VEN1/BR2V 

YTD Invoiced VEN1/BR2V 

 

Item 

 

Field Security based on the panel 

Acct No: COGS ITMC/ITCI 

Acct No: Inv ITMC/ITCI 

Acct No: Sales ITMC/ITCI 

ATP Flag ITM2/ITM4 

Avg Unit Price ITMC/ITCI 

Buyer ITM2/ITM4/BR2I 

Cost Family ITMC/ITCI 

Dec Prec Code ITM2/ITM4 

Demand Fence ITM2/ITM4 

Drawing ITM1/ITM3/BR2I 

ECCN ITM1/ITM3 

Family Grouping ITM1/ITM3 

Family Name ITM1/ITM3/BR2I 

Forecast Code ITM2/ITM4 

Forecast Prd ITM2/ITM4 

Gateway WC ITM2/ITM4/BR2I 

Group Tech Code ITM1/ITM3/BR2I 

HTS ITM1/ITM3 

Insp Required ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 
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Field Security based on the panel 

Item none 

Item Class 1 ITM1/ITM3/BR2I 

Item Class 2 ITM1/ITM3/BR2I 

Item Class 3 ITM1/ITM3/BR2I 

Item Class 4 ITM1/ITM3/BR2I 

Item Class 5 ITM1/ITM3/BR2I 

Item Class 6 ITM1/ITM3/BR2I 

Item Class 7 ITM1/ITM3/BR2I 

Item Class 8 ITM1/ITM3/BR2I 

Item Description none 

Item Pcs/Pkg ITM1/ITM3 

Item Pkg Type ITM1/ITM3 

Item Ref 1 ITM1/ITM3/BR2I 

Item Ref 2 ITM1/ITM3/BR2I 

Item Ref 3 ITM1/ITM3/BR2I 

Item Ref 4 ITM1/ITM3/BR2I 

Item Ship Vol ITM1/ITM3 

Item Ship Wgt ITM1/ITM3 

Lead Time: Fixed ITM2/ITM4/BR2I 

Lead Time: Insp ITM2/ITM4/BR2I 

Lead Time: Run ITM2/ITM4/BR2I 

Lot Size Day ITM2/ITM4 

Lot Size Min ITM2/ITM4 

Lot Size Mult ITM2/ITM4 

Lot Size Qty ITM2/ITM4 

Lot: Assign Pol ITM5/ITM6 

Lot: Avail Days ITM5/ITM6 

Lot: Counter ITM5/ITM6 

Lot: Default ITM5/ITM6 

Lot: FIFO Inv ITM5/ITM6 

Lot: Last Lot No ITM5/ITM6 

Lot: Last Ser No ITM5/ITM6 

Lot: Mask ITM5/ITM6 

Lot: Material ITM5/ITM6 
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Field Security based on the panel 

Lot: Retest Days ITM5/ITM6 

Lot: Ser No Dflt ITM5/ITM6 

Lot: Ser No Mask ITM5/ITM6 

Lot: Serializtn ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

Lot: Shelf Life ITM5/ITM6 

Lot: Trace Flag ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

Low Level Code ITM2/ITM4 

Make/Buy Code ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

NMFC Code ITM1/ITM3 

NMFC Sub-Class ITM1/ITM3 

Order Policy ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

Planner ITM2/ITM4/BR2I 

Planning Fence ITM2/ITM4 

Planning Policy ITM2/ITM4/BR2I 

Preferred Bin ITM2/ITM4/BR2I 

Preferred Stkrm ITM2/ITM4/BR2I 

Replan Code ITM2/ITM4 

Review Date ITM2/ITM4 

Revision Level ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

Safety Stock ITM2/ITM4 

Saleable Ind ITM1/ITM3 

Set Up Cost ITMC/ITCI 

Status ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

Type ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I 

UM ITMB/ITMI/ITM1/ITM3/ITM2/ITM4/ITM5/ITM6/BR2I/ 

ITMC/ITCI 

UPC Code ITM1/ITM3 

Yield % ITM2/ITM4 

 

Customer Order 

 

Field Security based on the panel 

Bill to Id SOP4 

CO Number none 

CO Rev Date COMT/COS1/SOP4 
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Field Security based on the panel 

Commission Code COS1/SOP4 

CSR COMT/COS1/SOP4 

Ctrl Currency COMT/COS1/SOP4 

Currency Code CUS2/COMT/COS1/SOP3/SOP4 

Cust Address 1 CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Cust Address 2 CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Cust City CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Cust Country CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Cust State CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Cust Zip CUS1/BR2C/COMT/COS1/SOP2/SOP4 

Customer Id COMT/COS1/SOP4 

Customer Name CUID/CUST/CUII/CUSI/COMT/COS1/SOP4 

Customer PO No COMT/COS1/SOP4 

Default Shp Date SOP4 

Disc Amt-CTL SOP4 

Distrib Region SOP4 

Distrib Zone SOP4 

End User Id SOP4 

Exch Rate 1 COMT/COS1/SOP4 

Exch Rate 2 COMT/COS1/SOP4 

Exch Rate Op 1 COMT/COS1/SOP4 

Exch Rate Op 2 COMT/COS1/SOP4 

Expiration Date SOP4 

FOB Point COMT/COS1/SOP4 

Freight Amt-CTL SOP4 

Freight Chg Code COMT/COS1/SOP4 

Gross Amt-CTL SOP4 

Invoice or COD COMT/COS1/SOP4 

On Hold SOP4 

Ord Open Amt-CTL COMT/COS1/SOP4 

Order Priority SOP4 

Order Status COMT/COS1/SOP4 

Price Adj S/D % COS1/SOP4 

RBPM Required SOP4 
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Field Security based on the panel 

Region Code SOP4 

Sales Category 1 COS1/SOP4 

Sales Category 2 COS1/SOP4 

Ship To Addr 1 COMT/COS1/CUS1/SOP2/SOP4 

Ship To Addr 2 COMT/COS1/CUS1/SOP2/SOP4 

Ship To City COMT/COS1/CUS1/SOP2/SOP4 

Ship To Country COMT/COS1/CUS1/SOP2/SOP4 

Ship Id/Dlvy Loc COMT/COS1/CUS1/SOP2/SOP4 

Ship To Id SOP2/SOP4 

Ship To Name COMT/COS1/CUS1/SOP2/SOP4 

Ship To State COMT/COS1/CUS1/SOP2/SOP4 

Ship To Zip COMT/COS1/CUS1/SOP2/SOP4 

Ship Via COMT/COS1/SOP4 

Shp:Mult Line SOP4 

Shp:Mult Order SOP4 

Shp:Partial Line SOP4 

Template Flag SOP4 

Term D:Csh1 % COMT/COS1/SOP4 

Term D:Csh1 Days COMT/COS1/SOP4 

Term D:Csh2 % COMT/COS1/SOP4 

Term D:Csh2 Days COMT/COS1/SOP4 

Term D:Csh3 % SOP4 

Term D:Csh3 Days SOP4 

Term D:Csh4 % SOP4 

Term D:Csh4 Days SOP4 

Term D:Net Days COMT/COS1/SOP4 

Term M:Cutoff Dy COMT/COS1/SOP4 

Term M:Day Due COMT/COS1/SOP4 

Term M:Mth Delay COMT/COS1/SOP4 

Terms Type COMT/COS1/SOP4 

Text line 1 COS1 

Text line 2 COS1 

Text line 3 COS1 

Text line 4 COS1 
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Field Security based on the panel 

Text line No COS1 

Total Lns – CTL COMT/COS1/SOP4 

Total Lns-NonCTL COMT/COS1/SOP4 

 

Manufacturing Order 

 

Field Security based on the panel 

Deliver To MOMT 

Gateway WC MOMT 

MO Number none 

MO Rev Date MOMT 

Order Status MOMT 

Planner MOMT 

Text Line 1 MOMT 

Text Line 2 MOMT 

Text Line 3 MOMT 

Text Line 4 MOMT 

Text No MOMT 

 

 
Purchase Order 

 

Field Security based on the panel 

Blanket Order POMT/POM1 

Buyer POMT/POM1 

Ctrl Currency POMT/POM1 

Currency Code POMT/POM1 

Exch Rate 1 POMT/POM1 

Exch Rate 2 POMT/POM1 

Exch Rate Op 1 POMT/POM1 

Exch Rate Op 2 POMT/POM1 

FOB Point POM1 

Order Cont Phone POM1 

Order Contact POM1 

Order Status POMT/POM1 

Orig Order Date POM1 
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Field Security based on the panel 

PO Number none 

PO Revision POM1 

Rev Date POMT/POM1 

Ship To Address1 POM1 

Ship To Address2 POM1 

Ship To City POM1 

Ship To Country POM1 

Ship To Name POM1 

Ship To State POM1 

Ship To Zip POM1 

Term D:Csh1 % POM1 

Term D:Csh1 Days POM1 

Term D:Csh2 % POM1 

Term D:Csh2 Days POM1 

Term D:Net Days POM1 

Term M:Cutoff Dy POM1 

Term M:Day Due POM1 

Term M:Mth Delay POM1 

Terms Type POM1 

Text Line 1 POM1 

Text Line 2 POM1 

Text Line 3 POM1 

Text Line 4 POM1 

Text No POM1 

Total Amt-CTL POMT 

Total Amt-NonCTL POMT 

Transport Via POM1 

Vendor Id VEDI/VEID/VEND/VENI/POMT/POM1 

Vendor Name VEDI/VEID/VEND/VENI/POMT/POM1 
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GL Master Account 

 

Field Security based on the panel 

Current Period Credits GLMA/GLJE 

Account Category GLMA/GLJE 

Account Description None 

Account Type GLMA/GLJE 

Active or Inactive GLMA/GLJE 

Balance Limit GLMA/GLJE 

Current Balance GLMA/GLJE 

Current Net Change Credits GLMA/GLJE 

Current Net Change Debits GLMA/GLJE 

Current Period Debits GLMA/GLJE 

Last Posted Date GLMA/GLJE 

Master Account None 

Master Account UserID GLMA/GLJE 

Open or Closed GLMA/GLJE 

Organization Description GLMA/GLJE 

Prior Net Change Credits GLMA/GLJE 

Prior Net Change Debits GLMA/GLJE 

Transaction Limit GLMA/GLJE 

 

Lot 

 

Field Security based on the panel 

Item Number None 

Lot Description LMST/LOTR 

Lot Number None 

Lot Number Mask LMST/LOTR 

Lot Revision LMST/LOTR 

Lot User Def 1 LMST/LOTR 

Lot User Def 10 LMST/LOTR 

Lot User Def 11 LMST/LOTR 

Lot User Def 12 LMST/LOTR 

Lot User Def 2 LMST/LOTR 

Lot User Def 3 LMST/LOTR 
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Field Security based on the panel 

Lot User Def 4 LMST/LOTR 

Lot User Def 5 LMST/LOTR 

Lot User Def 6 LMST/LOTR 

Lot User Def 7 LMST/LOTR 

Lot User Def 8 LMST/LOTR 

Lot User Def 9 LMST/LOTR 

Vendor Lot Number LMST/LOTR 

 

Specifying Criteria 

The Find feature enables you to search for data based on search criteria that you enter. By 

entering field values, you can filter the master list to a specific set of data. Criteria can be entered 

using several methods: 

 

Criteria Type Description Example 

Starting Characters You can enter the starting characters 

of data and the Find feature displays 

a list of all the data that begin with 

those characters. 

If you enter "12" in the Cust ID field, the 

Find feature displays a list of all customers 

whose identifiers start with "12", such as 

120001, 120002, and 120003. 

Wildcards You can enter a space before the 

criteria and the Find feature displays 

a list of the data that contains the 

specified criteria anywhere in the field 

value. 

If you know part of a customer identifier, 

you can enter it with a space (by pressing 

on the space bar) before it, such as 

"<space> 05". The Find feature displays 

all customers with "05" anywhere in the 

identifier, such as 050004, 100005 and 

100052. 

Multiple Criteria You can enter criteria in more than 

one criteria field and the Find feature 

displays a list of the data that matches 

all the criteria entered. 

If you enter "12" in the Customer ID criteria 

field and "San Diego" in the City criteria 

field, the Find feature displays a list of all 

customers whose identifiers start with "12" 

and whose city is "San Diego". 
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Using the Charting Feature 

The Charting feature provides a method for you to set up portals with frames that include tables 

and graphs. These frames are child frames that "listen" to the parent frame and display information 

accordingly. 

 

Setting Up the Portal 

When creating your portal, you need to select the FSChart frame type in order to use the Charting 

feature. See Add Charting Portal for more information on setting up a portal with the Charting 

feature. 

 

Using the Charting Samples 

Several graph and table samples are delivered with Fourth Shift WebUI. For example, the sample 

Inventory Location charts are child frames that listen to the ITMB and ITMC panels and the sample 

Customer Orders by Month, Customer Orders by Year and Orders by Month charts listen to the 

CUID and COCD panels. 

For example, you can create a portal that includes a Fourth Shift WebUI frame that defaults to 

ITMB (Item Master) or ITMC (Item/Workcenter Cost Data) and a charting frame that displays an 

Inventory Location graph and table. When the Fourth Shift WebUI frame changes from one item to 

another, the graph and table changes accordingly, displaying the information for the current item. 

 

Creating User-Defined Charts 

The Charting feature allows you to create your own charts. Use the pre-defined charts, located in 

workplace database as examples to create your own graphs and tables. My Fourth Shift 

Workplace contains a Chart Builder portal in the Portal Admin Group that can be used to create 

and maintain chart definitions. 
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Using SSII and SSIL (Stock Status by Item or Location) 

These screens offer the user an enhanced ability to display and filter inventory information by 

items and locations. At the bottom of the grid, a footer will show how many rows are being included 

in the results. 

Grid columns are sizeable, movable and can be sorted in ascending or descending sequence. An 

option using the Setting icon allows the grid to return to the default layout but the sort sequence 

will be maintained until the user either refreshes the screen or changes to a different sort 

sequence. 

The columns also have a dropdown menu of the types of filters that can be applied to that type of 

data and the value to be used. More than one filter can be applied to the grid rows. 

For example, the Inventory Value column can be filtered using qualifiers such as Equals, 

Greater than, Less than. 

The screens utilize keyboard activity of Arrows (Up/Down, Right/Left) and Tabs (Forward, 

Backward), remembered fields, and links to other Fourth Shift functions. 

The Settings icon also provides the ability to export the grid detail to an Excel spreadsheet. 
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Using Fourth Shift Portals 

With My Fourth Shift Workplace, you can create configurable views of information called portals. A portal 

can include the web-based version of the Fourth Shift program itself, as well as existing intranet resources, 

third-party browser-based applications, or even external Internet Web sites. 

Portals can include various types of information in a number of different arrangements. Each different area 

of information in the portal is called a frame. 

 
 

What is Included in a Portal? 

A Portal is a set of views to Fourth Shift data as well as data from other web sites. A Portal is set 

up as a collection of frames. The collection can represent a set of related data or a sequence of 

tasks that are completed. 

This collection of information can include a variety of Fourth Shift data, or some Fourth Shift data 

along with other web content from your corporate intranet or external internet resources. 

You can design portals to contain a variety of resources needed to perform a specific job. (For 

example, a portal for customer service representatives could include a set of commonly-used 

Fourth Shift screens, a customer relationship management system, and the DHL shipment 

tracking web site.) Portals can also provide an overview to a specific segment of your business, 

such as a segmented view of continuously updated management reports. 

There are a number of concepts you should understand about portals before you begin completing 

administrative tasks. Review and understand the following terms. 

 

Frames 

A Frame is an individual area of information displayed through a portal. Frames are a concept 

used in Internet browsers as well, and several types of frames included with My Fourth Shift 

Workplace provide enhanced communication between frames. These unique Fourth Shift frame 

types can publish data and subscribe to data for use in other frames. See "Frame Types" for more 

information. 

A portal can have a maximum of 20 frames defined by a maximum of 4 columns, each with a 

maximum of 5 rows. 

 

Portal Types 

Portal definitions are created in one of the following categories: 

• Public portals can be accessed by all users. This is useful for a general purpose portal, 

beginning a portal for other users or templates for users to begin with when constructing their 

own portal. 

• Private portals can be accessed only by the user that creates them. This allows users to 

create a number of specific portals that allow them to complete their jobs more productively. 

For example, users may create different portals for monthly tasks or for solving specific types 

of problems. 

Both public and private portals are organized into groups which allows you to locate portal 

definitions more quickly. You should consider assigning logical names to public groups such as 

department names or functional area descriptions. 
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Portal Manager 

The Portal Manager controls the frames included in the portal by managing the operation and 

communication between the frames. It also provides a way for you to define, manage and select 

portal definitions. 

The Portal Manager is automatically included in each portal definition. The Portal Manager 

consists of two primary elements: 

Portal Bar 
The portal bar is the top frame in the portal. It contains the identification title of Fourth Shift and 

several important features including: 

• Current Portal and Portal List access. On the left side of the Portal Manager frame is the 

portal list access button. The title on the button is the name of the portal you are currently 

viewing. When you click the title, the list is displayed. Clicking the title when the list is already 

displayed, hides the list. 

• Portal Security link. Allows you to grant portal admin access to current portal users, revoke 

portal admin access and view portal user account information. Only a portal administrator will 

see this icon. 

• Preferences link. Allows you to set up and create portal definitions and personal preferences. 

• Save Layout link. Updates the frame sizes and locations of the current portal to match the 

current display. This portal will then display with this layout when accessed. 

• Log Off link. Exits all Fourth Shift frames. This method of exiting Fourth Shift allows screen 

level validations to be completed when you exit the system. Closing the Internet Explorer 

browser does not communicate with the Fourth Shift frames so no validation is completed. It 

is highly recommended that you always use the Log Off link in the portal bar to exit My 

Fourth Shift Workplace. 

• Help button. Opens the online help for the Portal Manager within My Fourth Shift Workplace. 

The active tab in the help describes portals. Use the other tabs to learn about using the Fourth 

Shift specific frames like WebUI. 

Portal List 
The portal list includes all portal definitions that are available to you. Both public and private 

portals are available by clicking the button in the list that contains these items. Open the portal list 

by clicking the title of the current portal displayed on the left side of the portal manager. 

The following options are available as buttons in the list. 

• The Portal Admin portal group is visible only when you are logged in as the main portal 

administrator. It allows you access to all portals created by the main portal administrator for 

this portal group, as well as the default admin portals: Explorer Security and Remote Server 

Admin. 

• The Connectivity Toolkit portal group is visible only when you are logged in as the main 

portal administrator and you have this module installed. It allows you access to the portals that 

are part of the Connectivity Toolkit module used to customize the WebUI interface. 

• All Public Portals shows the public portal definitions that are available to all users, in a single 

list. 

A set of sample role-based public portals is installed with My Fourth Shift Workplace. These 

portals are provided to give you some ideas and a template to start building new portals, if 

desired. 

• Group Tree shows the list of public and private portals, by group, in a tree view. 
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• The names of any private groups defined for the specific user also appear as buttons in the 

Portal List. 

 
 

Frame Definitions 

Each frame is defined by a set of information, which determines how the frame behaves and 

relates to other frames in the portal. Frame definitions are maintained using the Preferences 

option on the My Fourth Shift Workplace toolbar. 

This frame definition consists of the following information. 

• Frame Title 

• Frame Type 

• Predefined Location 

• Parameters 

• Parent Frame 

• Fourth Shift User Information 

• Default Frame Settings 

Frame definitions are associated with both public and private portals. See "Portal Types" in the 

"Using Fourth Shift Portals" topic for more information. 

 

Frame Title 

Frame Title is the name displayed at the top of the frame. This title can include detailed 

descriptions of the content of the frame. When the frame is minimized, this title is still displayed to 

provide an easy way to identify the frame. 

 

Frame Type 

Frame type identifies the frame content and communication options available to other frames. The 

frame type determines the communication method available between frames and supplemental 

information that you can associate with a frame. This information might include information such 

as user identifiers and URL addresses. See "Frame-to-Frame Communication" for more 

information on communicating information between frames. 

The frame types include the following: 

 

Type Description 

FS Chart Runs the Fourth Shift charting application. 

FS Explorer Displays the Fourth Shift Explorer application tree for navigation and assistance 

when using FS WebUI type frames. 

FS Finder Runs the Fourth Shift Find application. 

FS UIEditor Runs the Fourth Shift UI Editor application. 

FS WebUI Runs a Fourth Shift session on the web server. 

Terminal Server Runs a a Windows (non-Web) application through Windows Terminal Server. 

Arbitrary Site Accesses a URL address for any web site that is not necessarily associated with 

Fourth Shift or one of the other frame types. 
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Type Description 

Named Site Similar to an Arbitrary Site in that it can be used to access any web site. How- 

ever, a Named Site allows the URL to be defined as a known location in the loca- 

tion list, and then simply referenced by name. 

KPI Display To display a Key Performance Indicator from the optional Business Intelligence 

module. 

 

Each Fourth Shift WebUI type frame starts a Fourth Shift application session or connection to 

Fourth Shift information. For example, if you are viewing two frames of WebUI information, you 

have started two Fourth Shift sessions. Note that sessions are not the same as Fourth Shift user 

licenses. In the previous example, the two sessions share one user license. 

Note: If a portal accesses multiple databases, it may consume multiple Fourth Shift licenses 

(one from each FS system). 

 

Predefined Locations 

Predefined locations, or names, allow you to create a reference to a server and then use that 

location name in the portal definition. The location names then allow the server definition to 

change as needed without interfering with the individual portal definitions. 

Because the predefined location names are used in the portal definition, choose names that 

clearly identify what the server accesses. For example, use a location name like Colorado Plant 

rather than a server name like CCSVR-21. 

Predefined locations are created by selecting the Preferences option on the My Fourth Shift 

Workplace toolbar and then clicking Locations. 

 

Parameters 

Parameters are supplemental characters passed when the web site is first accessed. Each frame 

type accepts different initialization strings. 

FS WebUI Frame Initialization 
Fourth Shift WebUI frames accept an initialization string which allows the frame to execute a 

predefined sequence of keystrokes. The following apply to these initialization strings: 

• Initialization strings for Fourth Shift WebUI type frames must start with a question mark (?) 

character. 

• The initialization string you enter is automatically sent when the frame displays. Be sure to 

input the same keystrokes as you would on a keyboard, including tabs between fields. 

• The initialization string can include literal keyboard characters such as a function code, or 

special keys such as the TAB key. Special keys are entered in braces. For example, to 

transport to the BILL screen and display the item 19-FRAME, enter the following as the 

initialization string: ?BILL{ESC}19-FRAME{CR}. See below for a list of special keys. 

• Special keys are not case-sensitive. 

• If you are including data values in an initialization string, it is recommended that you use 

{Ctab} instead of {Tab} for tabbing between fields. 
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The special key values available for use in initialization strings include the following: 

 

Keys Key Value 

ALT+BACKSPACE {@BS} 

ALT+ENTER {@CR} 

ALT+Function key {@F1}, {@F2}, {@F3}, etc 

ALT+TAB {@Tab} 

BACKSPACE {BS} 

BACKTAB {Btab} or {*Tab} 

CTRL+BREAK {Break} 

CTRL+DELETE {Del} 

CTRL+DOWN {Dn} 

CTRL+END {End} 

CTRL+ENTER {CR} 

CTRL+Function key {F1}, {F2}, {F3}, etc 

CTRL+HOME {Home} 

CTRL+INSERT {Ins} 

CTRL+LEFT {Lt} 

CTRL+PAGE DOWN {PgDn} 

CTRL+PAGE UP {PgUp} 

CTRL+PRINTSCREEN {PrtSc} 

CTRL+RIGHT {Rt} 

CTRL+UP {Up} 

CURSOR LEFT {Lt} 

CURSOR RIGHT {Rt} 

DELETE {Del} 

END {End} 

ESC {ESC} or {Escape} 

ENTER {CR} 

Function keys {F1}, {F2}, {F3}, etc 

HOME {Home} 

INSERT {Ins} 

PAGE DOWN {PgDn} 

PAGE UP {PgUp} 

SCROLL DOWN {Dn} 

SCROLL UP {Up} 
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Keys Key Value 

SHIFT+Function key {*F1}, {*F2}, {*F3}, etc 

SPACEBAR {Sp} or {Space} 

TAB {Tab} 

TAB (but not if the previous character trig- 

gered an Auto Tab Between Fields) 

{Ctab} 

 

Other External Frame Initialization 
Communication with frames containing other external web sites will vary. One way to determine 

the string used to navigate the web site is to manually click the options to access the desired page. 

Then review the URL address displayed to begin understanding what elements are included. The 

initialization string usually follows the URL address and begins with a question mark (?) character. 

Contact your Fourth Shift consultant if you want assistance in setting up complex external frame 

communication. 

 

Parent Frame 

Parent Frame identifies which frame in the portal should be used as reference data for this frame. 

This correlation allows you to link some frames to one parent and other frames to another parent. 

If this field is blank in the frame definition, the frame does not monitor data messages from another 

frame. My Fourth Shift Workplace will not automatically refresh the data in the frame. 

See "Frame-to-Frame Communication" for more information on communicating information 

between frames. 

 

Fourth Shift User Information 

Fourth Shift User Information is the security information needed to access Fourth Shift from this 

frame. The FS User Id and Password is used only with Fourth Shift specific frame types. 

Fourth Shift user information should be specified for private portals only. Passwords can be 

entered in the definition and the value is passed to the frame each time the portal is launched. 

 

Default Frame Settings 

Several defaults may be specified when defining frames for using the Find, Charting, terminal 

server, and Business Intelligence frames. 

Default Finder 
Default Finder identifies which type of data you are searching for when the Find feature is opened 

as an independent frame. You can specify to search for data such as customers, vendors, orders 

or items. 

When the Find feature is accessed as an independent frame using the FS Finder frame type, you 

can also specify how the find results are used. If you want the selected results to force navigation 

of a child Fourth Shift WebUI to a different screen, then check the Navigate Fourth Shift 

checkbox. Leave this checkbox blank if you want selections to merely suggest that a child Fourth 

Shift WebUI Frame move to the selected object. For example, when finding items, the WebUI 

Frame will display that item if it is currently displaying item information and it will ignore the 

selection if currently displaying vendor data. 

The default finder options are available when the Frame Type = FS Finder. 
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Default Chart 
Default Chart identifies which type of graph or table to access when the Chart feature is opened. 

You can specify to access information such as inventory location, customer orders by month, 

customer orders by year and orders by month. The default chart option is available when the 

Frame Type = FS Chart. 

Screen Size 
Screen Size identifies the amount of display space to setup for a terminal server frame. The 

Windows application you run will see this as its display resolution. 

Default Application 
Default Application is the initial Windows application that is started in a terminal server frame. 

This menu of applications can be customized and will be displayed again if you terminate the 

application. 

Default KPI 
Default KPI is the Key Performance Indicator selected to appear in this frame. 

 
 

Frame-to-Frame Communication 

My Fourth Shift Workplace expands on technology available in Internet browsers to allow frames 

to pass data from one frame to another. This communication allows frames to react or change 

based on information sent from another frame. Inter-frame communication allows you keep data in 

all related frames tracking so that when you move to view that frame, the necessary related 

information is already displayed. 

 

Terms 

Review the following terms related to frame-to-frame communication. 

• Parent frame is the frame that is the source of data communication. This frame publishes the 

data to the Portal Manager, which is running behind the scenes as part of My Fourth Shift 

Workplace. 

• Child frames listen for the data communication from their parent frame. The child frame 

reacts to the data by refreshing the content of the frame based on the new data. If no parent 

frame is listed, users need to interact with the frame directly to change the data displayed. 

• Fourth Shift frame types automatically support frame-to-frame communication. 

• External frame types can either be another organization's web content (like DHL or UPS) or 

your own corporate intranet or web site. External frames can use data from a parent frame but 

additional steps are needed to take advantage of the data. For example, you will need to 

identify initialization string elements to use in the URL address to refresh the external frame. 

• Links are used by WebUI to identify navigation possibilities. For example, the Item field is a 

link to the Item Master on many WebUI screens. Links are normally displayed underlined if 

you have set your Internet Browser option to show links that way. 

Links also are used by WebUI in the frame-to-frame communication process to define which 

data elements are published to other frames. See "Communication Process" for more 

information. 

 

Communication Process 
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Frames can communicate data between one frame and another. The methods used to 

communicate vary based on the frame type. The following rules apply to data communication 

between frames: 

• Linked Data. The data published by Fourth Shift WebUI frames is determined by the data 

elements that are links to other screens. In other words, a message is published for each link 

on the parent screen. 

• Parent/Child Relationships for Fourth Shift Frame Types. Fourth Shift frame types are 

able to take full advantage of the parent/child frame relationship. The linked data is 

communicated automatically between Fourth Shift type frames when the linked data is 

understood by the child frame. 

• Parent/Child Relationships for Non-Fourth Shift Frame Types. External frame types are 

not aware of data that might be published by Fourth Shift frames. You can, however, develop 

your own web pages that are equipped to understand these messages. Use the sample 

applications provided with My Fourth Shift Workplace to use as a guide in developing your 

own pages. See the files in the Inetpub\WWWRoot\FSPortals\Sample directory. 

External frames that are managed by another organization, like DHL or UPS, or are located on 

an external server can also be set up to respond to published data. However, setting up this 

communication can be complex. If you wish to establish this type of link, work with your Fourth 

Shift consultant for further assistance. 

• Communication Limitations. The communication feature builds upon technology embedded 

in Internet Explorer. This technology requires that the parent and child frames are both located 

within the same domain. Therefore if your Portal Manager is located on a site on server 

MyServer.MyCompany.com, the communicating frames can be on any server in the 

MyCompany.com domain. This means that Internet Explorer will not allow a frame from 

MyServer.MyCompany.com to communicate with a frame from 

YourServer.YourCompany.com. 

• Remembered Fields. The Remembered Fields feature in Fourth Shift WebUI allows you to 

navigate from one screen to another and retain key data being viewed on the previous screen. 

The Remembered Fields feature is available within a frame only. It is not available for frame- 

to-frame communication. 

 
 

Portal Images 

Each portal definition is associated with a graphic image. This graphic is displayed in the Portal 

List. You can select from the set of images installed with My Fourth Shift Workplace, or you can 

create a set of your own. 

If you create images: 

• Create the images in JPG format. 

• Use an image size with a width of 120 and a height of 60 pixels. 

• Save the final images in the InetPub\wwwroot\FSPortals\Images directory. 

 

Virtual Space 

The display space within the Internet Explorer can be managed in one of two ways: 

• You can select this option to place the frames within a large virtual desktop. 
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Each frame will consume its full size within this space and you can scroll the entire Internet 

Explorer window around the virtual desktop. 

• You can leave the portal’s space to be that of the Internet Explorer window and use each 

frame’s maximize button to expand the frame and reduce it back again to its original size. 

 

Running Microsoft Windows-based Applications in a Portal 

The Terminal Server frame type is used to run Microsoft Windows-based applications through a 

My Fourth Shift Workplace portal. For example, you can run Microsoft Access as part of a My 

Fourth Shift Workplace portal using the Terminal Server frame type. You can also run components 

of Fourth Shift that do not currently take advantage of web-based technology, such as the Sales 

Order Processing (SOPM) or Engineering (ENGM) module. 

A Terminal Server frame starts a Microsoft Windows Terminal Server session on a remote client. 

Windows Terminal Server allows you to use an application on the server to which you are 

connected as if you were actually sitting at the server. 

 

Implementing Terminal Server Frames 

Windows Terminal Server is an optional Microsoft component that can be installed as a part of 

your Windows Server or Windows Advanced Server installation. Once installed, Windows 

Terminal Server runs as an automatic service. However, Windows Server contains only a 

temporary license for using Windows Terminal Server, and you must purchase a permanent 

license from Microsoft Corporation before using Terminal Server frames. 

In order to use the Terminal Server frame type, it must be configured. Contact Fourth Shift 

Customer Support for more information. 

 

Starting Applications in a Terminal Server Frame 

When you create a portal with a Terminal Server frame, you select a default application to open 

automatically in the Terminal Server frame when the portal is started. If you close the default 

application during your portal session, you can use the application list to select another application 

to run in that frame. 

The application list is defined as part of the Terminal Server configuration process, using XML files 

stored in the InetPub\WWWRoot\FSPortals\WTS directory on the My Fourth Shift Workplace 

server. You can easily modify these files once the initial configuration has been completed. 

Alternatively, you may run any Windows application in the Terminal Server frame by selecting 

"Windows Desktop" as the startup application when configuring the Terminal Server frame. See 

"Run a Microsoft Windows-based Application" in the Fourth Shift Basics online manual for more 

information. 
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User Licenses and Terminal Server Frames 

All Fourth Shift applications that are run through a Terminal Server frame use the same single user 

license as long as they are started using one of the following methods: 

• the application is specified as the default application for the frame during portal setup 

• the application is selected from the application tree in the Terminal Server frame 

You can start a Fourth Shift application using a Terminal Server frame that displays the desktop if 

you wish, but any application started this way will consume an additional Fourth Shift user license. 

This method of starting Fourth Shift applications is not recommended. 

 

ASP Sessions and Terminal Server Frames 

Terminal Server Sessions are not the same as ASP sessions (for information on ASP sessions, 

see "My Fourth Shift Workplace User Information "). When the web browser connects to a terminal 

server, the ActiveX control in the frame establishes its own channel of communication with the 

Terminal Server, completely separate from the ASP session. Normally, it would be possible for 

different web browser instances, even on different clients to re-connect to the same Terminal 

Server session based solely on the use of the same Windows account when logging into the 

Terminal Server session. However, when a Terminal Server Session is started with a request to 

run an application at logon, an additional check is performed. 

The session is identified not only by the account name used to log in, but also by the command 

line used to start the application when the session begins. Therefore, a user will only re-connect to 

a particular session when using the same log in and the same command line. Since FS Portals 

passes the ASP session ID on the command line when starting an application for a Terminal 

Server session, there is a close correlation between ASP Sessions and Terminal Server sessions, 

even though they are considered separate. That means that closing the browser and starting a 

new one will never be able to connect a user to their old session because that unique session ID 

will not be assigned again. 

There are only two ways that a user could connect to an old session: 

• Leave the browser window open, switch between portals, and switch back to the original 

Terminal Server portal. Log in as the same user. Because the same user and the same 

command line will be sent (containing the same Session ID) the user will be re-connected to 

the session. 

• Switch to a Terminal Server frame that does not start up an application, but instead exposes 

the desktop. This will connect the user to any running session under the Windows account 

used to log in. If multiple sessions for that user are running, they will be presented with a list of 

sessions to select one. 

Because these sessions are difficult to reconnect to, My FS Workplace will attempt to clean up a 

session instead of allowing it to continue running after it is disconnected. The action is similar to an 

automatic log-off when the connection is broken (when the portal is closed or switched to another 

portal). That means there is practically no way to reconnect to a running session once a user 

disconnects from it. This frees up licenses that may have been in use by that session. If the log off 

fails because a running application contains unsaved data or cannot exit at the time, the session 

(and any applicable license locks) will remain active until the application closes cleanly or until the 

Terminal Server disconnected-session timeout expires. Then the session will be closed, forcefully 

if necessary. 
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Portal Administration 

Portal management can be done by users as well as administrators. You should consider how you 

wish to administer portals in your company as part of your overall system administration plan. 

The following are some administration considerations: 

• Portal definitions are stored in a Microsoft SQL Server (or SQL Express) database that is 

created when the server installation is done. This workplace database is called FSWorkplace 

by default. This technique allows users to run My Fourth Shift Workplace from any machine 

and use the portals defined for them. 

• The workplace database should be included in your daily backup if you are concerned about 

restoring this information in the event of a system failure. See "Performing Daily Backups" in 

the My Fourth Shift Workplace manual for more information. 

• The portal administrator is a user with the ability to perform the advanced administrative 

tasks for My Fourth Shift Workplace. By default, it is the user who installs the My Fourth Shift 

Workplace software who becomes the main portal administrator. Only a portal administrator 

can perform the following administrative tasks: 

- View and use the private admin portal groups (Portal Admin and Connectivity Toolkit) 

- Delete any public or private portal 

- Edit public portals 



Fourth Shift Release 8.00E 

WebUI 60 

 

 

 

 
 

Printing and Generating Reports in WebUI 

My Fourth Shift Workplace has printing and reporting features similar to the reporting functionality 

within Fourth Shift. 

 

Reporting Features 

• Most Fourth Shift screens can generate one or more reports. Select Preview or Print from the 

Reports menu to generate a report. 

• Many batch process tasks also generate reports. Use the BEXE (Batch Execution) screen to 

specify the Report Destination for batch process reports. 

- If Report Destination = 1, the report is displayed in a separate window. It is not 

printed directly. 

- If Report Destination = 2, the report is printed to disk on the Fourth Shift server. The 

report is not displayed on your computer. In order to view the report, you must access 

it using a LAN or dial-up connection. 

When you generate a screen report or batch process report, WebUI opens the report in a separate 

window after the report is generated. Each report opens a new window or in a new Internet 

Explorer tab. You can then print the report using any printer set up on your computer, or save the 

report to a file. 

Note: The report will not be displayed until it is completely generated. Depending on the 

complexity and amount of data in the report, you may experience a slight delay before 

the report is displayed. 

 

Template-based Reports 

For template-based reports, a browser window opens containing the web-enabled version of the 

Crystal Reports viewer. This window displays the report. 

 

RTF-based Reports 

For RTF-based reports, a browser window opens containing Microsoft Word or Microsoft Word 

Viewer, if they are installed on your computer, and if one of them is defined as the default 

application used to view RTF files. 

Other RTF file viewers will probably not be able to display reports acceptably. Reports are not 

displayed automatically in a browser window if you use an RTF file viewer other than Microsoft 

Word, Word Viewer, or Fourth Shift Report Viewer. Instead, you will be asked either to download 

the RTF file to their workstation for later viewing, or to open it directly on the server. 

Microsoft Office is Installed 
If Microsoft Office is installed on your computer, Microsoft Word is probably the default application 

used to view RTF files. You may want to consider changing the default application to Microsoft 

Word Viewer since that program will load more quickly than Word. Word Viewer is installed as part 

of the Word installation within Microsoft Office. 

When you use Microsoft Word or Word Viewer, be sure that your View option is set to Page 

Layout. This option displays the document header and footer, which may contain report data. 

Microsoft Office is Not Installed 
If Microsoft Office is not already installed on your computer, it is recommended that you install 

Microsoft Word Viewer. Contact your system administrator for instructions. 
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Fourth Shift Report Viewer may also be used with acceptable results, although reports will not 

display in a browser window. Contact your system administrator for assistance in setting up Fourth 

Shift Report Viewer as your default application for RTF files. 

 
 

Using Navigation Features 

Fourth Shift WebUI offers a variety of system-wide features designed to provide flexibility and 

consistency across modules. 

 

Using the Mouse 

You can use your mouse to complete the following actions: 

 

Action Description 

Select a menu option Move your mouse over a menu, such as Reports, Tools or 

Help, to open it; then click a menu option to select it. 

Select a portal bar link Click any portal bar link to perform the command. 

Move to related screen Click any active tab to go to the tab. Click any link or the Next 

Step icon to go to the screen. 

Go to an open field Click the field to move quickly to that field. 

Select from a list Click any item in a selection list. The dialog closes and the 

data is inserted into the open field. 

Activate a row Click on the line marker in a scrolling line to go to the first open 

field in that row. 

Select text Click and drag over text in an open field to select it, or double 

click in any open field to select an entire word. 

Go to the screen entered in the 

Function field 

Click the Go button, which is next to the Function field. 

Go to the previous screen Click the Back button, which is next to the Go button. 

Save data Click Submit, which is in the lower right corner of the panel. 

Change currency display Click Change, which is the lower right corner of the panel 

when the MCMM (Multi-Currency Management) Module is 

installed. 
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Using Menu Options 

Use the menu options to gain access to specific functionality. The menus are located in the upper 

right area of the screen and include the following: 

 

Menu Description 

Reports Generate reports for the screen. 

Use the mouse or Ctrl+R keyboard shortcut. 

Tools Access supplemental screen functionality, such as mass maintenance. 

Use the mouse or Ctrl+T keyboard shortcut. 

Help Use to gain quick access to context-sensitive help, including screen help, field 

help and field messages. 

Use the mouse or Ctrl+H keyboard shortcut. 

 
 

Using Tools 

My Fourth Shift Workplace WebUI has the same data entry and screen navigation tools as the 

traditional Fourth Shift program, but they are accessed differently. The data entry and screen 

navigation functionality is found on the Tools menu on My Fourth Shift Workplace. 

Selecting from a Browse or Detail List 
Use the Browse/Detail option on the Tools menu to select a record from a browse or detail list. 

For example, if you are on the CO Number field and you don't know the specific customer order 

number, use the Browse/Detail option to go to the Customer Order Browse screen. The Browse/ 

Detail feature can also be accessed using the CTRL+B keys. 

Setting up Defaults 
Use the Default Setup option on the Tools menu to activate the default mask and open the Mask 

Setup window. You can use the Mask Setup window as a tool if you need to enter repetitive or 

similar data. The Mask Setup option is not available from all screens, but on some screens it is 

available as a tab, in addition to the Tools menu. 

Using Extended Text 
Use the Extended Text option on the Tools menu to enter descriptive, context-specific text 

messages. The Extended Text option is not available from all screens. 

Performing Mass Maintenance 
Use the Mass Maintenance option on the Tools menu to select an action such as mass updates. 

Mass maintenance actions are screen-specific. Each Mass Maintenance Menu displays only the 

actions available on the current screen. 

Using Cash Reversal Selection 
Use the Cash Reversal option on the Tools menu to go to the Cash Reversal Selection window. 

This option is only available when you are on the ARCD (A/R Cash Deposits) or ARPD (A/R Prior 

Period Cash Deposits) screens. 

Adding Data 
Use the Add Data option on the Tools menu to open a new line to add data to your screen. The 

Add Data feature can also be accessed using the CTRL+A keys. 

Deleting Data 
Use the Delete Data option on the Tools menu to delete the selected line from your screen and 

from the database. The Delete Data feature can also be accessed using the CTRL+D keys. 
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Field Action 
Use the Field Action option on the Tools menu to perform an associated action for the current 

field. The Field Action option is only available from selected screens. The Field Action feature can 

also be accessed using the CTRL+F keys. You can use the Field Action option on the following 

screens: 

 

Screen Field Description 

Batch Process Execu- 

tion (BSET) 

Task Display the task parameter formats and require- 

ments. 

Parameters Validate the task parameters. 

Configuration of Inter- 

face Account Numbers 

(CNFA) F8 

Master Account No Display the organization and account description. 

Customer Order Action 

(COAN) 

Remaining Required 

Quantity or Ship Date 

Display the item quantity (Order Qty and Shipped 

Quantity) that is available to promise. 

Customer Order 

(COMT) 

Item Display the item description based on the type of 

item that was originally identified. 

Order Qty (no Prom 

Dlvry) 

Display the date the quantity is available. 

Order Qty (and Prom 

Dlvry) 

Display the availability of the quantity on the date. 

Prom Dlvry (no Order 

Qty) 

Display the quantity available on the date. 

Ship Id Scroll through ship ids until the desired information is 

displayed. Make changes as necessary and press 

ENTER. 

Tr LT Based on the transportation lead time and promised 

delivery date, display the calculated shipping date. 

Unit Price (field empty) For quoted customer items (LS = Q) display the 

quoted price, or the Customer Item Price defined for 

a previous order on the Custom Product Detail 

screen. 

Unit Price (field empty) For standard items (LS = S) display the calculated 

price. 

Unit Price (value 

entered) 

Display the adjusted price, or the comparison 

between the item's standard price and the actual 

price entered. 

Custom Product Main- 

tenance (CPMT) 

Quantity (no Due Date) Display the availability date for the quantity or capac- 

ity. 

Quantity (and Due 

Date) 

Display the availability of the quantity or capacity 

based on the specified date. 

Due Date Display the available quantity or capacity for a spe- 

cific date. 

Customer Name/ 

Address Detail (CUS1) 

Ship Id Scroll through ship ids until the desired information is 

displayed. Make changes as necessary and press 

ENTER. 
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Screen Field Description 

G/L Recurring/Tem- 

plate Trans Detail 

(GLR1) 

Cycles Determine the number of cycles completed to date. 

Planner Action 

(MOAN) 

Open/Suggested Order 

Qty 

Display the item quantity (Quantity Ordered and 

Quantity Shipped). 

Option Selection 

(OPSL) 

Configuration Qty / 

Reqd Date 

When an item is set up on the Planning Detail 

screen to calculate ATP quantities (ATP = Y or P) 

you can determine when the required quantity is 

available and /or what quantity is available on a spe- 

cific date. 

Buyer Action by Ven- 

dor (POAN/POAS) 

Open/Suggested Order 

Qty 

Display the item quantity (Quantity Ordered and 

Quantity Rcvd) 

Picklist (PICK) Reverse Quantity Display information on quantity required, issued and 

allocated. 

Purchase Order 

(POMT) 

Unit Price Load the unit price for the new order quantity as 

defined on the POCT screen. 

PO Line Item Detail 

(POM2) 

Conv or UM Display the most current values. 

Bill of Lading (SBOL) Ship to Id Scroll through existing ship ids; press ENTER to 

select one 

Ship (SHIP) Reverse Quantity Display information on quantity required, issued and 

shipped. 

Shipment Quantity Display information on quantity required, issued and 

shipped. 

Packaging Detail 

(SHI1) 

Package Typ, Line 

Item Quantity, Weight 

or Volume 

Calculate the package values. A net change might 

be calculated when adding items to an existing pack- 

age. 

Weight Calculate the package weight when you combine 

items in packages. 

 

Toggling Currency Information 

Currency information is displayed in a boxed area near the bottom of the WebUI frame if your 

Fourth Shift system includes the Multi-Currency Management Module (MCMM). Currency 

information includes the currency description and exchange rate. 

Click the Change button to toggle all monetary values on the screen between the local currency 

and the foreign currency. 
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Using Portal Bar Links 

Use the portal bar to gain access to specific functionality. The portal bar links are located in the 

upper right area of My Fourth Shift Workplace portal and include the following: 

 

Link Description 

Portal Security To grant and revoke admin rights. Only shown for a portal 

administrator. 

Preferences Edit portal and location preferences. 

Save Layout Allows you to save changes to the size and position of the 

frames within the portal layout. 

Log Off The preferred method to close My Fourth Shift Workplace. 

Help Opens help for My Fourth Shift Workplace. 

 

 

Differences in My Fourth Shift Workplace 

Several differences exist in My Fourth Shift Workplace with which existing Fourth Shift users may 

not be familiar. 

 

Fourth Shift WebUI Compared to Fourth Shift GUI 

• Reports generated from My Fourth Shift Workplace are displayed on screen in a browser 

window if Report Destination = 1 (printer) on the BEXE (Batch Execution) screen. This allows 

you to select a desired printer. 

• Files generated by the following tasks in My Fourth Workplace are created on the server 

instead of on your workstation: ACCX (Access Extract), ASCX (ASCII Extract), DBSX (dBase 

Extract) and EXLX (Excel Extract). You also can transfer these files to your client if desired. If 

you want these files to be generated on your local machine, you need to use the traditional 

Fourth Shift program. 

• On the BEXE (Batch Process Execution) screen, the ability to show or hide details is no longer 

needed since detail messages are always shown during processing. Also, the Stop button has 

been split into two buttons called Stop Task and Stop Batch so that a second dialog is not 

needed. 

• The following parameter functionality is no longer available when using the IMPT (Data 

Import) and RCVR (System Recovery) tasks: 

- S Parameter: Step Mode. The Step Mode ability of the S parameter is not available 

in WebUI. The Step Mode ability allowed you to start the import process in single step 

mode so you could review each keystroke for troubleshooting purposes. The other S 

parameter abilities, such as allowing you to Pause, Continue or Stop, are still 

available. 

- Vx Parameter: View Mode. The View Mode (Vx) parameter is not available in WebUI. 

This parameter allowed you to control how the user interface was displayed during 

import processing. You could hide transaction processing (VH), minimize the entire 

Fourth Shift session (VM) or show transaction processing (VS). 

The specified parameter functionality is not needed to save processing time. WebUI will 

always run in a manner similar to using hidden windows for the fastest performance. 
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You can use the traditional fat client Fourth Shift program to run the IMPT and RCVR tasks 

using the S parameter for Step Mode and the Vx parameter for View Mode, if desired. 

• The size of each screen is based on its original size in Fourth Shift. For example, several 

detail screens in Fourth Shift WebUI are smaller than the main screens because these detail 

screens were smaller than the main screens in Fourth Shift. 

• Several Fourth Shift modules do not take advantage of My Fourth Shift Workplace web-style 

features. See "Restricted Features" in the My Fourth Shift Workplace manual for more 

information on which modules need to run under a Windows Terminal Server frame. 

 

Internet Explorer Options Compared to Fourth Shift WebUI 

Several similar menu options and buttons are available from your Internet Explorer (IE) browser 

and from within Fourth Shift WebUI. 

• Menus. Use the menus from the IE browser if you want to use the IE browser functionality. For 

example, use Internet Options from the Tools menu to configure your browser. Use the menu 

options from within Fourth Shift WebUI if you want to use Fourth Shift functionality. For 

example, use Browse/Detail from the Tools menu to open browse or detail windows. 

• Buttons. Use the buttons from the IE browser if you want to use the IE browser functionality. 

For example, click the Favorites button to open your list of favorite sites. 

It is recommended that you do not use the first group of buttons (Back, Forward, Stop, Refresh 

and Home) from the IE browser while you are working in Fourth Shift WebUI. Instead, it is 

recommended that you use the buttons from within Fourth Shift WebUI to use Fourth Shift 

functionality. 
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My Fourth Shift Workplace: How Do I? 

This section is a guide to the activities or tasks you can perform using My Fourth Shift Workplace. 

Each activity includes: 

• Procedures—the step-by-step instructions for performing the activity. 

• Tips—this section includes important notes, pointers, and standard information you should 

know in order to perform the activity. 

For detail information on using a specific Fourth Shift screen, choose Screen Help from the Help 

menu. Activities are separated into functionality categories. 

 

Add Charting Portal 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click the Add a New Portal icon. 

3. Enter the Portal Name. 

4. Select the Private/Public portal type. 

5. Do one of the following to select the Portal Group. 

- Select an existing group from the drop-down list 

- Click New Group to display the Add New Group -- Web Page Dialog window. 

a. Add a New group name for your user information. 

b. Select the Private or Public portal type. 

c. Click OK. 

6. Select whether you want this to be in a large virtual space or not. 

7. Select the Layout tab. 

8. Define the number of frames in this portal. 

9. Enter frame definition information for your portal: 

- frame title 

- frame type = FS Chart 

- location 

- parent frame = Frame A or B—select the one where the Fourth Shift WebUI frame is 

located, based on your portal layout 

- default charts 

10. Click the Image tab and select an image for your portal. 

11. Click the Save button to save your changes, or click the Add button again to discard your 

changes. 

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 

list of portal groups, select the group where your new portal is defined. From the list of 

portals, click the new portal. 
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Tips 
• To select a chart that starts by default when the portal is accessed, expand the Default Chart 

list and select a graph or table. 

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 

section of the My Fourth Shift Workplace manual for more information. 

 

Add Finder Portal 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click the Add a new Portal icon. 

3. Enter the Portal Name. 

- This name must be unique from all other portals that you have created. 

- If it is a public portal, the name must be unique name from all other public portals. 

4. Select the Private/Public portal type. 

5. Do one of the following to select the Portal Group. 

- Select an existing group from the drop-down list. 

- Click New Group to display the Add New Group -- Web Page Dialog window. 

a. Add a New group name for your user information. 

b. Select the Private or Public portal type. 

c. Click OK. 

6. Select whether you want this to be in a large virtual space or not. 

7. Select the Layout tab. 

8. Define the number of frames in this portal. 

9. Enter frame definition information for your portal: 

- frame title 

- frame type = FS Finder 

- location 

- parent frame = Frame A or B—select the one where the Fourth Shift WebUI frame is 

located, based on your portal layout 

- Fourth Shift log on information 

- navigation = select if you want the Find feature (parent) to navigate Fourth Shift 

WebUI (child) based on the Find feature's data selections. 

- default finder 

10. Click the Image tab and select an image for your portal. 

11. Click the Save icon to save your changes, or click the Add icon again to discard your 

changes. 

12. Click Close to exit the portal update process. 
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Note: To view your new portal, click Start Portals in the My Fourth Shift portal bar. From the 

list of portal groups, select the group where your new portal is defined. From the list of 

portals, click on your new portal. 

Tips 
• When accessing the Find feature through a portal frame, you are prompted to log on to Fourth 

Shift. If your user’s authentication is “Fourth Shift” on the PASS screen, you can enter this log 

on information (user id and password) when creating the frame type so that you are not 

prompted for it when the Find portal is accessed. 

• When the Find feature is defined as a parent frame, an option is available to set the level of 

navigation: 

- Option Selected. The Find feature (parent) sends a message to Fourth Shift WebUI 

(child) and Fourth Shift WebUI changes to the desired screen and the data is entered 

into the appropriate field. 

- Option Not Selected. The Find feature (parent) sends a message to Fourth Shift 

WebUI (child) and if the desired screen is already displayed, the data is entered into 

the appropriate field. If the desired screen is not displaying the desired screen, the 

data is not entered. 

• To select a finder that starts by default when the portal is accessed, expand the Default 

Finders list and select a finder. 

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 

section of the My Fourth Shift Workplace manual for more information. 

 

Add Portal Definition 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click the Add a New Portal icon. 

3. Enter the Portal Name. 

- This name must be unique from all other portals that you have created. 

- If it is a public portal, the name must be unique name from all other public portals. 

4. Select the Private/Public portal type. 

5. Do one of the following to select the Portal Group. 

- Select an existing group from the drop-down list 

- Click New Group to display the Add New Group -- Web Page Dialog window. 

a. Add a New group name for your user information. 

b. Select the Private or Public portal type. 

c. Click OK. 

6. Select whether you want this to be in a large virtual space or not. 

7. Select a Layout tab. 

8. Define the number of frames in this portal. 
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9. Enter frame definition information. 

For example, enter the frame title, frame type, location, parent frame and default settings to 

customize your portal. 

10. Click the Image tab and select an image for your portal. 

11. Click the Save icon to save your changes or click the Add icon again to discard your changes. 

12. Click Close to exit the portal update process. 

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 

list of portal groups, select the group where your new portal is defined. From the list of 

portals, click your new portal. 

Tips 
• Public portal definitions are available for any user to access but they can only be changed or 

deleted by the portal administrator. 

• Private portal definitions are saved by your Windows login identifier. 

• If you wish to create a new portal group, click New Group and enter the new group 

information. 

• Portal images must exist in the Inetpub\WWWRoot\FSPortals\Images directory. You can add 

.JPG files to this directory, if desired. 

• Portal layout can only be defined when you create a new portal definition. 

• Initialization string values differ by frame type. See "Initialization String" in the Portal Manager 

section of the My Fourth Shift Workplace manual for more information. 

• Several optional settings are available for FS Finder and FS Chart frame types, such as 

specifying the default Chart or Find type, and whether the Find results navigate the Fourth 

Shift application. 

 

Add Portal Group 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click the Add a New Portal icon. 

3. Click New Group to display the Add New Group dialog window. 

4. Add a New group name for your user information. 

5. Select the Private or Public portal type. 

6. Click OK. 

The portal group is now available for use in a portal definition. 

Tips 
• Portal groups can be deleted and given to other users in a group tree. 

• Private groups are saved by your Windows login identifier. 
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Add Predefined Locations 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click Locations. 

The Edit Known Locations dialog is displayed. 

3. Enter a new Location Name. 

4. Enter a Location URL. 

5. Enter the Configuration File. 

6. Select one or more of the Supported Frame Types. 

Note: The Arbitrary site and Named Site Frame Types are always supported. 

- FS Chart 

- FS Explorer 

- FS Finder 

- FS UIEditor 

- FS WebUI 

- Terminal Server 

7. Click Add New. 

The Defined Locations list is updated and your new location is listed. 

Note: Because the Location Names are visible to users, we recommend using names that 

clearly identify what the URL address accesses. For example, use a location name 

like Colorado Plant rather than a server name like CCSVR-21. 

 

Change Default Portal 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Select one of the predefined portals from the Default Portal drop-down list. 

3. Click the Save icon. 

The Edit Preferences/Portal screen displays the Changes saved message. 

Tips 
• Only public portals and your private portals can be selected. 

• Create a new portal if none of the predefined portals meet your needs. 

• To change back to the original default portal, select the Start Portal option from All Public 

Portals panel or click the Start Portal button in the upper-left corner. 

• You can customize the links in the original default portal. 

For example, you can customize the "Your Company Home Page" link by updating the default 

link with your own company home page address. 
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Change Portal Definition 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Select the portal you want to work with from the Portal Maintenance drop-down list. 

3. Click the Edit this Portal icon. 

4. Use the General Layout and Image tabs to display and change the definition. 

For each frame in your portal, review and update the frame detail as needed. 

5. Click the Save button to save your changes, or click the Edit button again to discard your 

changes. 

6. Click Close to exit the portal update process. 

Tips 
• The Portal layout option cannot be changed. You must create a new portal to change the 

number or configuration of frames. 

• If you wish to change the order of the frames, change the frame definitions to display the 

desired content. 

 

Change Predefined Locations 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click Locations. 

3. Highlight the Defined Location you wish to change. 

4. Review and change the Location Name if necessary. 

5. Review and change the Location URL if necessary. 

6. Review and change the Configuration File if necessary. 

7. Update the Supported Frame Types. 

8. Click Update. 

Tips 
• Changes to predefined locations are available to users immediately. 
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Delete Portal Definition 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Select the portal you want to work with from the Portal Maintenance drop-down list. 

Important: Deleting a portal is permanent—there is no Undo. 

3. Click the Delete this Portal button. 

The Delete Confirmation dialog message is displayed. 

4. Verify that this is the correct portal then click Yes. 

Tips 
• Portal definitions must be recreated if you accidentally delete a portal. 

• Public portals can only be deleted by the Portal Administrator. 

 

Delete Predefined Locations 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click Locations. 

3. Select the location you want to delete from the list displayed for Defined Locations. 

Important: Deleting a location is permanent—there is no Undo. 

4. Click Delete. 

The location is deleted and the Defined Location list is automatically updated. 

Tips 
• If the predefined location is referenced in a portal definition, the predefined location cannot be 

deleted. 

 

Access Help 

Several methods are available for accessing help for My Fourth Shift Workplace and portals. 

Context-Sensitive Help in Fourth Shift WebUI 
1. Use the options in the Help menu on the current tab to review context-sensitive help for the 

function. 

2. Click the X in the upper-right corner of the help window to close the window. 

My Fourth Shift Workplace and Portals 
1. Click the Help link in the My Fourth Shift Workplace portal bar. 

2. Use the tabs to review the detail on using My Fourth Shift Workplace and portals. 
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Close My Fourth Shift Workplace 

Important: We strongly recommended that you do not use the Internet Explorer Close button ( ) 

to exit My Fourth Shift Workplace. Closing the Internet Explorer does not exit the Fourth 

Shift WebUI application—it will continue to run until the session times out. 

1. Click the Log Off link in the upper-right corner of My Fourth Shift Workplace portal. 

The Goodbye page is displayed and you are notified that the Fourth Shift Portals session has 

ended. 

2. Do one of the following: 

- Click the Internet Explorer Close button ( ) to close the browser window. 

- Click the here link on the Goodbye page to start a new My Fourth Shift Workplace 

session. 

Tips 
• You are not allowed to close My Fourth Shift Portal session if you have not completed the 

current transaction in a Fourth Shift WebUI frame. For example, from the APIE (A/P Invoice 

Entry) screen, a warning message is displayed if you click the My Fourth Shift Portal button 

before you've completed the G/L distribution. 

• We recommend that you use the Log Off portal bar link to exit My Fourth Shift Workplace. 

 

Select Portal from List 

1. Click Start Portal or the portal name in the My Fourth Shift Workplace portal bar to open the 

portal manager (in the upper left-hand corner). 

2. Select one of the following to open a list of available portals. 

- Group Tree—to view a hierarchical tree of private and public groups. 

- All Public Portals—to view a list of available public portals. 

- Private Group Name—to view a list of your private portals in that group. 

3. Click the portal icon located above the portal name you want to work with. 

Your selected portal is displayed automatically. 

Note: Click the portal or group name to toggle between show or hide when displaying the list 

of portals or groups. 

Tips 
• Private portal definitions are only available to the user who created them. 

• To change back to the original default portal, select the Start Portal option. 

 

Run a Microsoft Windows-based Application 

1. Click the Preferences link in the upper-right corner of My Fourth Shift Workplace portal. 

The Edit Preferences/Portal screen is displayed. 

2. Click the Add a New Portal icon. 

3. Enter the Portal Name. 

4. Select the Private/Public portal type. 

5. Do one of the following to select the Portal Group. 
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- Select an existing group from the drop-down list 

- Click New Group to display the Add New Group -- Web Page Dialog window. 

a. Add a New group name for your user information. 

b. Select the Private or Public portal type. 

c. Click OK. 

6. Select whether you want this to be in a large virtual space or not. 

7. Select the Layout tab. 

8. Define the number of frames in this portal. 

9. Enter frame definition information—select Type = Terminal Server for at least one of the 

frames. 

This is the frame through which you can run an external application. 

10. Select the Default Application you would like to run through the Terminal Server frame. 

For example, if you would like to run the Fourth Shift Shop Calendar in this frame, expand the 

"Fourth Shift WTS Applications" tree and select "Fourth Shift Shop Calendar." This is the 

application that will start by default when the portal is started. 

11. Click the Image tab and select an image for your portal. 

12. Click the Save button to save your changes, or click the Add button again to discard your 

changes. 

13. Click Close to exit the portal update process. 

Note: To view your new portal, click Start Portal in the My Fourth Shift portal bar. From the 

list of portal groups, select the group where your new portal is defined. From the list of 

portals, click on your new portal. 

Tips 
• Private portal definitions are only available to the user who created them. 

• If you want to run any Windows desktop application from a Terminal Server frame, select 

"Windows Desktop" as the startup application when configuring the Terminal Server frame. 

 

Save Find Feature Settings 

1. Open the Finder feature either as a frame or a popup window from WebUI. 

2. Select the fields to display in each column. 

3. Specify filter criteria, if desired. 

4. Click the Reload data icon. 

The results are displayed in the Finder pane. 

5. Click the Save settings icon. 

Tips 
• Settings are saved differently separately for each type of Finder. 

• Settings are saved by workstation, not by User ID. You must have the necessary Internet 

security that allows cookies to be stored on your workstation in order to save settings. 



Fourth Shift Release 8.00E 

WebUI 76 

 

 

 

 

Specify Finder Feature Criteria 

1. Do one of the following to open the Finder feature: 

- From a field within Fourth Shift WebUI: 

a. Point to the Find icon. 

b. If this field has a menu of options, use the down arrow to display it. 

c. From the list displayed, select Find <data>. 

- From a portal frame: 

a. Select the portal from your portal group that has been assigned the FS Finder 

frame type. 

b. If prompted, log on to Fourth Shift using the appropriate authentication mode 

defined in PASS. 

2. Select the fields to filter by and specify filter criteria, if desired. 

3. Click the Reload data icon. 

4. Click the arrow row marker to select the data. 

The data is entered into the active field. 

- The Finder feature closes, if it was accessed from within Fourth Shift WebUI. 

- The Finder feature remains open, if it is a separate portal frame. 

Tips 
• As an alternative, you can press Ctrl+Down Arrow to open the list and then press the up/ 

down arrow keys to move within the list. Tab or Enter will select the highlighted item. 

• Click the Clear Criteria icon to remove the filter criteria from all fields. 

• Click the Save settings icon to retain your sort order and filter criteria for the current session. 

• If starting data was entered in the originating field before accessing the Find feature, this data 

is automatically entered into the filter criteria. If starting data was not entered, the Find feature 

opens and you can enter filter criteria in the row of available fields. 

• When entering criteria, you can enter a space before the specified value in order to display a 

list of all the identifiers that contain the criteria anywhere in the identifier. Without the space, 

the list includes only the identifiers with the criteria as starting characters. 

• To change the sort order, click on the header of another column. To reverse the sort order 

from ascending to descending, click on a column header that is already sorted. The sort order 

is saved when Save Settings is selected. 

• The Finder feature uses field-level security, which allows only the users who are assigned the 

appropriate security to see certain fields. See the Assigning Security topic, in the Fourth 

Shift Basics online Help, for more information on security for the Find feature. 
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Using Fourth Shift Report Viewer 

Fourth Shift Report Viewer is a program used to display reports before they are printed, or to open 

previously saved reports. It allows you to view any page of the report, and print the report on any 

printer set up on your computer. You can also save the report as a file on your computer, or open 

a previously saved report. 

You can access Fourth Shift Report Viewer from any screen that generates a screen report by 

choosing Print Preview from the File menu. The Print Preview option is available only for screen 

reports. You can also access it by selecting Report Viewer from the Fourth Shift Tools menu. 

Fourth Shift Report Viewer can open, print and save both template-based and RTF-based reports. 

 

Printing Reports in Fourth Shift Report Viewer 

Do one of the following to print a report from Fourth Shift Report Viewer: 

• Choose Print from the File menu to specify a printer or fax machine, or to specify a range of 

pages to be printed 

• Click Print on the toolbar to print the entire report on your computer's default printer 

To change the paper size, specify portrait or landscape orientation, or modify any other printer 

settings, choose Print Setup from the File menu before printing the report. 

 

Previewing Reports in Fourth Shift Report Viewer 

Fourth Shift Report Viewer allows you to preview a report on your screen before it is printed. You 

can check the layout and content of a report before printing, or simply review and close a report 

without printing. 

Normal and Preview Views of RTF Files 
Fourth Shift Report Viewer provides two viewing options for previewing a report: Normal and 

Preview. Each time Fourth Shift Report Viewer opens, it is in Normal view. To switch to the 

Preview mode, select Print Preview from the File menu. Click Close to return to the Normal view. 

The viewing option you choose does not affect the layout of the actual report. In Preview mode, 

you can do the following: 

• see the printer margin area 

• print the report 

• display one page at a time, or two pages side by side 

• zoom in for a detailed view or zoom out to see the overall layout of the report 
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Moving Between Pages 
Many reports contain more than one page. In Normal view mode, page breaks are shown on your 

screen by a dotted horizontal line. In Normal view, do one of the following to move between pages 

in a report: 

• Use the vertical scroll bar to scroll between pages 

• Use the toolbar buttons or the options in the View menu to move to the first, next, previous or 

last page 

• Enter a specific page number in the toolbar then press Enter 

Print Preview and Action Messages 
A number of Fourth Shift action messages instruct you to print a specific document. Typically, 

when you print the document, the action message is deleted. 

For these documents, selecting Print Preview is treated the same as printing the document. 

• If you choose to Print Preview one of these documents, Fourth Shift assumes that the 

document has been printed, and the action message is deleted. 

• Do not use Print Preview for these documents unless you plan to print the report at that time. 

These action messages include: 

 

 
Action Messages 

 
Description 

Document Printed 

From 

ACK Print order acknowledgment COMT 

PMO Print manufacturing order CPMT, MOMT 

PPL Print picklist PICK 

PPO Print purchase order POMT 

 

Saving Screen Reports Using Fourth Shift Report Viewer 

After you have previewed a newly-generated, or previously-saved, screen report, you can use the 

Fourth Shift Report Viewer to save it to a file. 

Other Ways to Save a Screen Report 
If you want to save a screen report (if available) without previewing it first, use the Print Export 

from the File menu. You can choose from several file formats when saving the report using the 

Print Export option. 

 

Viewing Batch Process Reports Using Fourth Shift Report Viewer 

Reports generated by batch process tasks are printed to disk as a file if you selected Report 

Destination = 2 for the task. 

You can view these reports only after they are created. You cannot preview a batch process report 

as part of the batch process itself. You can, however, add a line to a batch process that opens the 

report using Fourth Shift Report Viewer, prints the report automatically, or converts the report file 

to plain text format. For more information, see Fourth Shift Report Viewer Command Line 

Parameters. 

Open the Fourth Shift Report Viewer by choosing Report Viewer from the Tools menu. Locate 

the report you want to view and click Open. Be sure to select All files in the Files of type box, 

because batch process report files use the Process Id of the batch process as the file extension. 
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Note: If you regularly need to view report files, you may want to customize the toolbar by 

adding a button that opens the Fourth Shift Report Viewer. For more information, see 

the Customizing the Toolbar topic in the Fourth Shift Basics online Help. 

 

Converting Saved Reports to Plain Text Format 

There may be times when you need to convert a screen or batch process report file to plain text 

(TXT) comma-delimited format. Although you cannot change the file format when you save the 

report, you can run the Fourth Shift Report Viewer (FSPRINT.EXE) silently, using a command line 

parameter that performs this conversion. 

The syntax for this command line parameter is as follows: 

M:\MFGSYS\SYSTEM\FSPRINT.EXE <report file name> /text <text file name> 

For example, to convert the saved batch process report file M:\MFGSYS\PORR01.PUR to a plain 

text file in the same directory with a .TXT file name extension, use a command line similar to the 

following: 

M:\MFGSYS\SYSTEM\FSPRINT.EXE M:\MFGSYS\PORR01.PUR /text 

M:\MFGSYS\PORR01.TXT 

You can perform this conversion using any command line execution method, such as a batch file, 

batch process, shortcut, or the Run dialog box. For more information on operating Fourth Shift 

Report Viewer from a command line, see “Fourth Shift Report Viewer Command Line 

Parameters.” 

 

Adjusting Report Fonts and Margins 

You can change the look of your printed RTF-based reports by modifying the fonts and margins. 

To do this, you must add or modify lines in your FS.CFG (or [system name]LOCALFS.CFG) file. 

The default font for reports is 10 point Courier New. You can modify this by changing value of the 

RtfReportFontName configuration variable. You can improve the speed of report printing on dot 

matrix printers by using a printer font instead of a TrueType font. 

The default margin on the left side of the page is 13/36 inch, with no top, bottom or right margin. To 

modify these characteristics, add or change the following configuration variables: 

 

Configuration Variable Description 

RtfBarCodeFontName Name of bar code font 

RtfBarCodeFontSize Size, in ½ points, of bar code font 

RtfReportFontName Name of standard report font 

RtfReportFontSize Size, in ½ points, of standard report font 

RtfReportFontSizeCompress Size, in ½ points, of report font in compressed width areas 

RtfReportLineSpacing Distance between baselines of consecutive lines 

RtfTwipsMarginTop Size of top margin 

RtfTwipsMarginBottom Size of bottom margin 

RtfTwipsMarginRight Size of right margin 

RtfTwipsMarginLeft Size of left margin 

RtfTwipsGutter Size of gutter 
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Configuration Variable Description 

RtfTwipsHeaderY Position of report header 

RtfTwipsFooterY Position of report footer 

 

Note: These configuration variables have no effect on template-based reports. You can 

adjust the report fonts and margins on those reports by customizing the report 

template. 

For more information, see "Configuration Variables" in the System Administration manual. 

 

Fourth Shift Report Viewer Menus 

Fourth Shift Report Viewer has three menus containing options for displaying, saving and printing 

reports. 

 

Fourth Shift Report Viewer Command Line Parameters 

You can create a shortcut to the Fourth Shift Report Viewer, or include it in a batch process or 

batch file, by using the following command line syntax: 

FSPRINT <filename> [/title <title>] [/dir <dir>] [/save [<outfile>] | / 

print [/ask] | /text [<outfile>] | /showopen] 

 

Parameter Description 

<filename> Specifies the name and fully qualified path of the file to be opened, printed or 

converted. 

/title <title> Used to set the window title of the document when opened in Fourth Shift Report 

Viewer. 

/dir <dir> Used to set the default directory of the document when opened in Fourth Shift 

Report Viewer. 

/save <outfile> Used to save <filename> directly to the specified name and fully qualified path; if 

no <outfile> is specified, the Save As dialog box is displayed. This parameter can 

not be used with the /print, /text or /showopen parameters. 

/print [/ask] Used to print <filename> directly to the default printer set up for the workstation. 

If /ask is specified, the Print dialog box is displayed, allowing a choice of printers 

and other options. This parameter can not be used with the /save, /text, or / 

showopen parameters. 

/text <outfile> Used to convert <filename> to a plain text, comma-delimited file with the 

specified name. If no <outfile> is specified, the Save As dialog box is displayed. 

This parameter can not be used with the /save, /print, or /showopen parameters. 

/showopen Used to display the Open dialog box. This parameter can not be used with the / 

save, /print, or /text parameters. 

 

 

In the following example, Fourth Shift Report Viewer is used to print a saved batch process report 

to the default printer after it is generated: 

M:\MFGSYS\SYSTEM\FSPRINT.EXE M:\MFGSYS\PORR01.PUR /PRINT 
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Report Templates 

Many Fourth Shift reports are generated using templates that define not only the data that appears 

on the reports, but the layout and formatting of the reports as well. 

There are no differences in the actions you take to generate template-based screen reports or 

template-based batch process reports. However, template-based reports provide you with 

additional options for generating customized output, or multiple outputs of a single report. 

Screen reports and batch process reports that are not generated using a template are generated 

instead as RTF (Rich Text Format) based documents. 

Note: The templates used to generate these reports can be customized to change the layout 

of the report, or even the data contained in the report. For detailed instructions, see 

"Customizing Report Templates" in the System Administration manual. 

Choosing Report Formats 
When you use template-based reports, you can export reports to files in different formats such as 

PDF and CDF (Comma Delimited File). These files can then be viewed at a later time or used as 

input for processing by custom applications or distributed via email. 

 
 

Printing External Documents 

Fourth Shift generates a number of documents that are either distributed to your trading partners, 

or used to conduct business transactions with your trading partners. Many are designed to be 

printed on preprinted forms, although you can customize the templates used to generate the 

documents and print instead on plain paper. Or you can choose to email the reports automatically. 

External documents are produced in a variety of ways. For example: 

• Customer order acknowledgments, purchase orders and shipping documents are generated 

as screen reports. 

• Invoices, order acknowledgements, and customer statements are generated as batch process 

reports. 

• Checks and 1099 forms are generated as the result of screen processing. 

For lists and samples of the external documents produced by Fourth Shift, see "Documents that 

Use Preprinted Forms" in the Getting Started manual. 

 

Printing on Preprinted Forms 

You may choose to print external documents, such as bills of lading, invoices and checks, on 

preprinted forms. If you are using preprinted forms, most of these documents offer alignment tests 

as part of the printing process. Use the alignment test before beginning a print run to ensure that 

the preprinted paper forms are correctly loaded in the printer. 

Note: You are not required to use preprinted forms. Optionally, you can customize the report 

template used for printing external documents, and print them on plain paper using a 

laser printer. For more information on customizing report templates, see "Customizing 

Report Templates" in the System Administration manual. 
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Administering My Fourth Shift Workplace 

Typical Fourth Shift system administration is changed in some ways once you implement My Fourth Shift 

Workplace in your operation. Additional considerations are needed for tasks such as automated 

processing and configuration options. You may also need to complete additional changes when updates 

are needed in your environment. 

Administration of the client computer is much easier. No updates or setup is needed when applying an 

upgrade to the server. 

 
 

Batch Processing Considerations 

Batch processes are defined using the Batch Process Setup (BSET) screen and run using the 

Batch Process Execution (BEXE) screen. You can set up and run batch processes using My 

Fourth Shift Workplace as well as a traditional client. 

The architecture of My Fourth Shift Workplace completes batch processing activities on the Fourth 

Shift server. This means that output from these processes are saved to the Fourth Shift server. 

The following considerations apply when running batch processes: 

• Batch Process Reports. When a batch process runs, reports are generated either to a file on 

the Fourth Shift server (Report Destination = 2) or previewed in the browser (Report 

Destination = 1). Once displayed, the user can choose to print the report or save it to a file. If 

the user wishes to use a report file that has already been generated (Report Destination = 2), 

the file must be transferred to the user's computer through a LAN or dial-up connection after 

the processing is complete. 

• Output Files. Several screens and tasks generate output files such as audit trail files, data 

files used to create custom documents such as statements, or off-loaded history data. These 

files are created only on the Fourth Shift server. If the My Fourth Shift Workplace user needs 

to review or access this output file, the file must be transferred to the user's computer through 

a LAN or dial-up connection after the processing is complete. 

Examples of these type of screens and tasks include: 

- GLAU (G/L Account Update) task which creates a series of electronic reports detailing 

actions completed by the processing 

- ARBS (A/R Statement Export) task which creates a set of customer statement 

document data files 

- AUDP (Item History Purge) screen which off-loads item history into a file. 

For other batch processing differences when using My Fourth Shift Workplace, see "Differences in 

My Fourth Shift Workplace" in the Fourth Shift Basics manual. 

 
 

Performing Daily Backups 

It is recommended that you stop the My Fourth Shift Workplace web site and terminate any client 

sessions before starting the backup process. See "Managing User Connections" in this manual for 

more information. 

Fourth Shift (workplace) database backups require a single point of control for the database. This 

means that all client sessions must be terminated and the Fourth Shift database must be brought 

up in single-user mode. 
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Add the workplace support database to your daily backup. This database is located in the SQL 

Server (or SQL Express) and is called FSWorkplace by default. 

 
 

Managing Portal Access Security 

You can allow portal users access to some portal administrator features by using the Portal 

Security feature (the link on the Portal Bar). 

 

Adding Portal Admin Access 

1. Log in to My Fourth Shift Workplace as portal administrator. 

2. Select the Portal Security link from the Portal Bar. 

3. Select the Administrator Privilege checkbox to check it. 

4. Click Save. 

 

Revoking Portal Admin Access 

1. Log in to My Fourth Shift Workplace as portal administrator. 

2. Select the Portal Security button from the Portal Bar. 

3. Clear the Administrator Privilege checkbox. 

4. Click Save. 
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Changing Portal Group Owner 

Any user can change the owner of their own portals to make them public. However, only the main 

portal administrator, or any users with portal admin access, can change the owner of a public 

portal as well as any private portal. When you change the owner of a portal group, the owner of all 

portals in that group are changed also. 

1. Log in to My Fourth Shift Workplace as the portal administrator or as a user with portal admin 

access. 

2. Select the Group Tree portal from the Portal List. 

3. Right-click on the portal group where you want to change the owner. 

4. Select Change Owner. 

5. Select the portal user to be the new owner and click Submit. 
 
 

Managing User Connections 

My Fourth Shift Workplace uses standard IIS web server technologies for running the site. This 

means that the Internet Services Manager is used to control the site operation. 

In order to complete intensive or exclusive processing on the Fourth Shift database server, like a 

nightly batch processing run, you may wish to close any open client connections and stop the My 

Fourth Shift Workplace site so no new users can connect. You can use the Fourth Shift Active 

User List portal in the Portal Admin group to see who is logged into the system (fat and thin client 

connections will be listed). Instructions for stopping the web server are as follows. 

 

Stopping the Web Server 

Web server processes can be stopped several ways. The following method is recommended 

because it closes any active user sessions immediately. 

1. Click the Start button and choose Run. 

2. Type: NET STOP IISADMIN 

3. Click OK. 

 

Restarting the Web Server 

Web server processes can be restarted several ways. The following method is recommended 

because it can be included in automated scripts if necessary. 

1. Click the Start button and choose Run. 

2. Type: IISRESET /NOFORCE 

3. Click OK. 

User sessions are not restarted automatically. 
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My Fourth Shift Workplace User Information 

Fourth Shift Licenses 

My Fourth Shift Workplace tracks access to the Fourth Shift system by Internet Explorer sessions. 

The frames within a single Internet Explorer session all share one Fourth Shift license to a 

particular database. Therefore, just as with multiple Windows applications, a user consumes only 

one Fourth Shift license from each Fourth Shift database accessed. 

Note: Additional Fourth Shift licenses will be consumed for each additional Internet Explorer 

session (browser window) used. Also, if a portal accesses multiple Fourth Shift 

databases, it will consume a single Fourth Shift license from each system (just as the 

Windows application would). 

 

Adding Portal Users 

A user is added to the list of portal users automatically after they log onto My Fourth Shift 

Workplace for the first time. Their Windows login will determine if they are permitted to access to 

the Workplace server. 

 

Maximum WebUI Instances 

The My Fourth Shift Workplace server can host many instances of Fourth Shift concurrently. How 

many instances will depend on the hardware used and on users' specific activity. A modern server 

could handle up to 200 instances of Fourth Shift concurrently. 

Each WebUI frame in an open Internet Explorer session represents an instance of Fourth Shift on 

the My Fourth Shift Workplace server. 

For example, suppose 3 users are logged into the My Fourth Shift Workplace. Users A and B each 

have one Internet Explorer session open on their desktop, while User C has two Internet Explorer 

sessions open. Licenses and instances are consumed like this: 

 

User Number of WebUI Frames in portal Licenses Instances 

A 1 1 1 

B 2 1 2 

C (session 1) 3 1 3 

C (session 2) 1 1 1 

TOTAL  4 7 

 
 

If your site needs more WebUI instances than your server can handle, you can simply install an 

additional My Fourth Shift Workplace server for your Fourth Shift database. The second install of 

Workplace can also point to the original FS Workplace database so this information is shared 

between servers. 

 

UserDir Location 

The UserDir configuration variable is used to define a unique location for files created when a user 

is signed onto Fourth Shift. Each client must have a user-specific subdirectory on the My Fourth 

Shift Workplace server. This subdirectory has the same name as the IIS session id. 
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When a My Fourth Shift Workplace user accesses the system, the IIS session id is appended to 

the FSWebUI\UserDir location. The subdirectory is created automatically for use by session 

processing. When the session closes, the subdirectory is automatically deleted. 

Note: If you configure the My Fourth Shift Workplace server to run Windows Terminal 

Server, the UserDir location must be modified. This configuration process is 

completed by a Fourth Shift consultant. Contact Fourth Shift Customer Support for 

more information. 

 
 

Technical Details About ASP Sessions 

An ASP session is established when an Internet Explorer instance makes a request to the web 

server. The session contains data (such as associated with a running instance of FSGuiApp.exe) 

that the server needs to remember the next time that the same client accesses the server. In order 

to associate the client request with the server data allocated to the client, a unique ID is returned to 

the client. The ID is supplied with each subsequent request in the form of a cookie. This cookie is 

a memory-resident cookie and is lost when the web browser on the client is closed. Starting a new 

instance of the browser will cause the whole process to begin again with a new ID. 

Because sessions are associated with licenses: 

• Multiple WebUI frames in a single client browser can share a license. 

• Two browsers running in separate sessions will require separate Fourth Shift licenses. 

Sessions are assigned by the server: 

• A single client browser that contains a portal that accesses multiple servers, may require 

multiple licenses. 

If Frame A accesses WebUI on SERVER1 and Frame B accesses WebUI on SERVER2, there 

will be two separate sessions created because of the two separate servers. If these servers 

target the same database, they will require separate licenses when accessing the database. 

Terminal Server sessions are not exactly the same as ASP sessions: 

• There are other considerations when using Terminal Server frames (see "ASP Sessions and 

Terminal Server Frames"). 

 
 

Default IIS Settings 

During the installation process, a number of scripts are run to set up the IIS configuration using the 

recommended settings. The following settings are defined and should not be changed without 

the recommendation of Fourth Shift Customer Support. 

 

Portal-Specific Settings 
 

Setting Value Assigned 

Anonymous access Not allowed 

Site access Challenge/response 

Script timeout 90 seconds 

Session timeout 20 minutes 

Portal database Prevent download 
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Fourth Shift WebUI Settings 
 

Setting Value Assigned 

Script timeout 90 seconds 

Session timeout 4 minutes 

Out of Process ASP will start new process 

 

 

Using Multiple Fourth Shift Systems 

Each frame that accesses Fourth Shift data must know the location of the data. Each location is 

defined by the URL address of the server, and the configuration file on that server. These two 

pieces of information (along with a “friendly” name) are combined to form a location that is defined 

in the Portal Preferences page. 

Two Fourth Shift systems can be on separate servers and have two different URL addresses, or 

they can both be on the same server and have the same URL address but different configuration 

files. 

Use the following steps to update or add the Fourth Shift system name in a multiple system 

environment. 

1. On the My Fourth Shift Workplace Welcome screen, click the Preferences link in the portal 

bar. 

2. Click Locations. 

To update—Select the portal name from the Defined Locations list. 

To add—enter the new name in the Location Name field. 

3. Enter the Configuration file (FS.CFG) location for the system you wish to use. 

If desired, add the system name of the Fourth Shift system to the beginning of the Location 

Name. Be sure to include " – " (a space followed by a hyphen and another space) after the 

system name. 

4. Enter the URL for the workplace server in the Location URL field. 

5. Click Update. 

6. Click Close to close the Locations window. 

7. Repeat these steps for additional locations. 

A location must be created for each Fourth Shift system, and each location must define the 

appropriate configuration file. 

8. Click Close to close the Preferences window. 
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Troubleshooting Tips 

Active Sessions exist but no users are running 

Sessions are terminated by users either by closing Internet Explorer or by using the Log Off link 

on the My Fourth Shift Workplace toolbar. When users close Internet Explorer, the session timeout 

feature is applied by IIS. This means that there may be up to a 4 minute wait for the session to 

clear. You may wish to train your users to use the Log Off link on the My Fourth Shift Workplace 

toolbar. 

 

Error Occurs Repeatedly for a Single User 

A unique working environment based on session identifier is created each time you start My 

Fourth Shift Workplace. It is possible that the working environment can become unstable based on 

a variety of environment factors. You may wish to develop a standard practice of having users 

close Internet Explorer and starting again to create a fresh working environment before attempting 

other problem solving. 


